Table of Contents

General Overview of PennERA ................................................................. 6

Section Overview................................................................................. 6

Pre-Award ......................................................................................... 6

Submission of Proposals to Sponsors ............................................... 6

Electronic Notification of Award Notices ......................................... 6

Post Award Management ................................................................. 6

Data Reporting for Management .................................................... 6

System Features and Process Overview ......................................... 7

Getting Started with Proposal Development ................................. 8

Create Proposals – Process Overview ............................................. 8

Navigation Features ......................................................................... 10

Common Icons ................................................................................ 10

Logging into PennERA Proposal Development ............................ 11

PennERA Portal ............................................................................... 12

Working in the PennERA Portal ..................................................... 13

My Action Items and My Messages ............................................... 14

My Profile ....................................................................................... 16

My Profile > General ..................................................................... 16

My Profile > Biosketch ................................................................. 17

My Profile > Delegates .................................................................. 18

My Profile > Education ............................................................... 19

My Profile > Resources ............................................................... 20

My Profile > Sponsor Credentials .............................................. 21

My Profile > Settings ................................................................. 22

Working in PennERA My Proposals .............................................. 23

My Proposals > Show List ............................................................ 23

My Proposals > Search For .......................................................... 23

My Proposals General Features .................................................... 25

Buttons, Drop Down Boxes, Links, Etc......................................... 25

Upload Documents, Warnings, etc ............................................... 26

Completed ....................................................................................... 27

Exiting a proposal record ............................................................... 27
General Overview of PennERA

Section Overview

Electronic Research Administration (ERA) is the term used to describe the methods of conducting research administration in an integrated and automated environment. In its broadest definition, it encompasses both pre- and post-award processes that involve the administrative and regulatory aspects of sponsored projects. PennERA includes the following (items in **Bold** are included in the current Proposal Development phase):

**Pre-Award**

- Identification of funding opportunities
- Proposal development
- Institutional and faculty profiles
- Approval routing (including regulatory and other approvals)
- Budget development
- Cost sharing information
- Subcontracts tracking

**Submission of Proposals to Sponsors**

- Electronic (to sponsors who have the capability)

**Electronic Notification of Award Notices**

- Automatic notification
- Automated project setup

**Post Award Management**

PennERA feeds this information to other Penn systems, such as the Data Warehouse, for:

- Project financial management
- Sponsor invoicing
- Project closeout and reporting
- Effort reporting

**Data Reporting for Management**

- Timely and accurate reporting at all phases of the project life cycle
- Ability to slice and dice information
System Features and Process Overview

The Proposal Development application provides tools that will improve efficiency and enhance Penn's ability to obtain funding from sponsors. The Proposal Development Application features include:

- Ability to create proposals electronically
- Ability to electronically assemble proposals
- Ability to route proposals through the approval hierarchy
- Ability to electronically review and approve proposals
- Ability to electronically submit proposals to the sponsor
- System-wide reusability of Profile and department information
- Automatic population of University-wide information (e.g., DUNS#, FWA#)
- Application support of Sponsor-specific form sets
- Ability to track the progress of proposals through the internal review and approval process

The Proposal Development process consists of 6 major tasks:

Proposal Development Process Overview

- Validate Profile Sections
- Create Proposal
- Finalize and Submit Proposal for Internal Review
- School Internal Review
- ORS Review
- Submit to Sponsor

- Verify name
- Verify address
- Verify Commons ID
- Verify Fax
- Verify Title
- Electronic submission by ORS
- Paper-based submission by Investigator

A complete list of the funding mechanisms that can be prepared and submitted as electronic system-to-system (S2S) proposals via Proposal Development can be found on the PennERA website PennERA Electronic Submission Reference Materials.

- Most competitive proposals that cannot be prepared as S2S submissions via the Proposal Development application are processed PD as generic template records.
Getting Started with Proposal Development

In order to get started with your Proposal make sure you have verified and/or updated your Profile information in PennERA:

- Ensure that your name appears as you prefer it to appear on proposals.
- Verify that your email address is present and correct.
- Verify and, if necessary, correct your NIH Commons ID.
- Verify and, if necessary, correct/enter your **FAX #, Title, and County**.

An investigator’s name in his/her PennERA Profile is the same as it appears in the Penn Community (typically how the name appears in Payroll). However, the name an investigator uses in the sponsored research community may be different. If an investigator prefers to use his/her professional name on proposals, s/he should manually change the name in the PennERA profile.

**Note:** For all NIH submissions through Grants.gov, your NIH Commons ID and name must be exactly the same as it appears in the NIH Commons. Be sure to check capitalization, as this information is case sensitive.

Investigators should make any changes to their Profile information before they begin using PennERA to create proposals, so that the information will be incorporated into any proposals created.

**Create Proposals – Process Overview**

Creating a Proposal using the Proposal Development application requires that you complete a series of questions and forms. The Proposal Development application will lead you through the proposal development process and generate the appropriate questionnaires and forms based on the Sponsor you select. The Proposal Development application validates the information you enter and alerts you to any errors or incomplete items.

Once you have completed the various parts of the Proposal, you can assemble the proposal and prepare it for internal review.

---

**Create Proposal Process**

![Proposal Development Process Diagram](Diagram.png)
How to Get Help with Training

This User's Guide is designed to let you access any or all of the components listed in the Table of Contents. You can advance through all the sections sequentially or you can jump around from section to section.

If you experience difficulty using any of the training materials, send an email to pennerahelp@lists.upenn.edu with a brief explanation of the problem.

How to Get Help after Training (End User Support)

If you experience a problem or have a question once you have finished training and begin using the Proposal Development application, please take the following steps:

- Use the Support link on the PD application to contact the PD Support Group.
- Send an email with your question or a description of the problem to pennerahelp@lists.upenn.edu.

Institution Number and What It Means

The Institution Number (or Proposal Number) is an automatically generated number specific to PennERA. This number will help users track a proposal throughout its University of Pennsylvania life cycle.

Security

Security within PennERA is role-based. Principal Investigators will have access to any proposal for which s/he is the Principal Investigator. Administrative staff will have access based on pre-defined security roles determined by their Organization.

Delegating Authority

A user may grant another user certain access rights and authority. By doing so, that user may act on your behalf to either view or edit proposals.

- Go to “Profile” and select the “Delegation” function and select the person to whom you are delegating authority.

Functions by Role

Depending on your role within the Organization, you will have the ability to perform certain tasks within the Proposal Development application. The chart below provides a high-level description of the roles and associated tasks:

Proposal Development Roles

<table>
<thead>
<tr>
<th>Role</th>
<th>Create</th>
<th>Review</th>
<th>Approve</th>
<th>Submit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Investigator</td>
<td>Create or modify Proposals</td>
<td>Submit for internal review</td>
<td>Respond to rejected</td>
<td></td>
</tr>
<tr>
<td>Administrator</td>
<td>Create or modify Proposals</td>
<td>Review Proposals</td>
<td>Approve or Reject Proposals</td>
<td></td>
</tr>
<tr>
<td>Other Approvers</td>
<td></td>
<td>Review Proposals</td>
<td>Approve or Reject Proposals</td>
<td></td>
</tr>
<tr>
<td>ORS</td>
<td></td>
<td>Review Proposals</td>
<td>Approve or Reject Proposals</td>
<td>Electronically submit Proposals</td>
</tr>
<tr>
<td>Other Central Admin</td>
<td></td>
<td>Review Proposals</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Navigation Features

The Proposal Development application has been designed with navigation features that are common in many Windows and Web applications. Read and follow instructions on the screen display. Common navigational conventions are used throughout the application; some examples are described below:

### Common Icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Done</strong></td>
<td>Located on the top left of a Proposal page, closes the proposal that you’re working on. It is important to click [Done] when finished working with a specific proposal. While multiple users may view and edit different sections within a proposal, only one person may edit a specific proposal page at a time.</td>
</tr>
<tr>
<td><strong>Save</strong></td>
<td>Located on the top left of a Proposal page, saves your changes on the current page. This option is available only if you have been assigned Edit access. The system will prompt you to save your changes if you edit a page and fail to use the Save button when exiting the page.</td>
</tr>
<tr>
<td><strong>Logout</strong></td>
<td>Located in the Portal Toolbar, exits you from the module or the PennERA Portal.</td>
</tr>
<tr>
<td><strong>Help</strong></td>
<td>Located in the Portal Left Sidebar, points you to InfoEd help modules for general system help.</td>
</tr>
<tr>
<td><strong>Support</strong></td>
<td>Located in the Portal Left Sidebar, opens to web form where you can request help from PennERA End-User Support providers.</td>
</tr>
<tr>
<td><strong>Edit</strong></td>
<td>Opens the corresponding form or page in edit format, security level permitting.</td>
</tr>
<tr>
<td><strong>Delete</strong></td>
<td>Deletes the corresponding item, security level permitting.</td>
</tr>
<tr>
<td><strong>View</strong></td>
<td>Opens the corresponding form or page in view format, security level permitting.</td>
</tr>
<tr>
<td><strong>In Use</strong></td>
<td>Indicates that you or someone else is currently working in the proposal.</td>
</tr>
<tr>
<td><strong>Upload</strong></td>
<td>Uploads an attachment located after browsing your directories.</td>
</tr>
<tr>
<td><strong>Replace</strong></td>
<td>Opens the corresponding window in which to replace an existing document with a newer version.</td>
</tr>
<tr>
<td><strong>Remove</strong></td>
<td>Remove an uploaded CV (biosketch).</td>
</tr>
<tr>
<td><strong>Remove-Document</strong></td>
<td>Removes an item from the current list or location within a record.</td>
</tr>
<tr>
<td><strong>Completed</strong></td>
<td>Designates a tab (section) that when checked has been completed.</td>
</tr>
<tr>
<td><strong>Open</strong></td>
<td>Opens the corresponding report, query, access log, or history session.</td>
</tr>
<tr>
<td><strong>Access Log</strong></td>
<td>Shows past history of who has accessed a particular section of the proposal.</td>
</tr>
<tr>
<td><strong>Envelope</strong></td>
<td>Indicates if a PennERA site mail message has been opened or not opened. The yellow envelope indicates a message that has not been read. An open white envelope is a message that has been read.</td>
</tr>
</tbody>
</table>
Logging into PennERA Proposal Development

Logon to PennERA Proposal Development from the PennERA home page (https://www.pennera.upenn.edu/).

You will need your PennKey and Password to authenticate and enter the application. Information on PennKey can be found at http://www.upenn.edu/computing/pennkey/.

• Click [LOGON to PennERA].
• Type your PennKey and Password.
• Click [Log in] to authenticate.
The PennERA Portal Page is the point of entry into the PennERA Proposal Development system.

- The PennERA logo at the top of the PennERA Portal Page is embedded in the Toolbar. Toolbar is only available on the Portal Page.
- The Sidebars on the left and right sides of the screen are used to access the different PennERA modules.
- When you click any one of the Toolbar links or the Sidebars, the system displays that page.

**Toolbar**
1. **Find Funding** - Opens the SPIN (funding opportunities) database, enabling easy access to new funding opportunities.
2. **CV Database** - Opens the GENIUS CV Database for collaborative efforts
3. **Logout** - Exits you from the PennERA Portal and opens modules

**Left Sidebar**
4. **My Profile** - All PennERA users have a profile with basic address and contact information provided from the Penn Community directory that you should verify and update. See also “Getting Started with Proposal Development” for additional information. SMARTS (funding opportunities email alert service) Access Settings to customize your PennERA screens.

**Right Sidebar**
1. **My Action Items** - Items requiring user action, for example, review and approval of proposals. ‘My Open Action Items’ are automatically displayed when the portal screen is first displayed after login.
2. **My Messages** - Messages received from the PennERA internal messaging system.
Working in the PennERA Portal

Overview
After logging onto the application, the Main Menu, referred to as the **Left and Right Sidebars**, are located on the left and right sides of your screen.

Features
- To expand a Menu Option, click on the menu item.
- Additional submenu items are displayed.
- Navigate to proposals from either Show/List or **Search For** in **My Proposals**

Left Sidebar

<table>
<thead>
<tr>
<th>Expanded View</th>
</tr>
</thead>
<tbody>
<tr>
<td>My Proposals</td>
</tr>
<tr>
<td>My Human Subjects</td>
</tr>
<tr>
<td>My Animal Use</td>
</tr>
<tr>
<td>My Profile</td>
</tr>
</tbody>
</table>

Right Sidebar

<table>
<thead>
<tr>
<th>Expanded View</th>
</tr>
</thead>
<tbody>
<tr>
<td>My Action Items</td>
</tr>
<tr>
<td>My Workflow Maps</td>
</tr>
<tr>
<td>My Messages</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>My Action Items</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
</tr>
<tr>
<td>Completed</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>My Workflow Maps</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>My Messages</th>
</tr>
</thead>
</table>
My Action Items and My Messages

PennERA messages are site mail or messages sent within the PennERA application. Users who are required to approve a proposal will be sent a University e-mail and may access the proposal to be approved through My Messages or My Action Items. Users may message other PennERA users using site mail as well as respond to proposals routed for approval/review via the messaging system.

My Action Items

Overview

When you enter PennERA, you are in the My Action Items module. Action Items are items awaiting the user’s review and/or approval, such as proposals.

- At any time you can access Action Items by clicking on My Action Items to open the Review Dashboard.
- Click on the Open icon to review a specific item.
- Previously reviewed and completed items may be viewed by clicking on ‘Completed’ under ‘My Action Items’.

My Messages

Overview

PennERA has internal messaging or site mail. Each user has a mailbox within PennERA that allows the user to send/receive messages to other users within the PennERA community.

In certain instances PennERA will automatically generate a PennERA message as well as send a University e-mail:

- When a proposal has been routed to an individual for review or approval
- If a proposal is returned to you for changes or correction
Features

Below is an example of an “Approval Needed” message. At the top of the message are icons that will allow you to manage your messages. In the body of the message are links to view the proposal, or open the reviewer dashboard to approve or disapprove the proposal.

From: Mr. Swovely, Todd S
To: Ford, Evelyn J - 8760 - Research Services
CC: 
Subject: Approval Needed - 10023443 - 8760 - Research Services

Proposal 10023443 submitted by ORG 8760 - Research Services for STEPHEN FRATANTARO from 8760 - Research Services requires your approval. Your prompt attention to this request is appreciated. If you have any concerns about the proposal, please contact your departmental administrator.

To review, approve or disapprove this proposal click: Reviewer Dashboard

Attachments:

Open Reviewer Dashboard to enter decision (if an approver)

Open Proposal (security rules determine who can access)
My Profile

Overview

Your PennERA profile can be used to manage a variety of information including: biosketch, employment and education history, etc. Select the appropriate menu option to open screens that allow you to add/update this information.

My Profile > General

Overview

All PennERA users have a profile with address and contact information that is initially setup from their Penn Community information and continues to be updated nightly from the online directory. Changes to your profile general information should be made through the online directory whenever possible.

Note: Making a change directly to your PennERA profile will disable the nightly update from the Penn Community.

You may also edit your profile

REQUIRED fields – Address, city, state, country, Email, and phone information are required fields for submission of electronic proposals.

Note: Title, fax, and county are no longer required for NIH electronic submissions. However, it is recommended that users supply information for all the fields in their profiles, as these validations may change and also may be required as other sponsors are included in the electronic submission process through Proposal Development.

- Click [Save] to save any changes you have made to your profile in the PennERA system.
My Profile > Biosketch

Overview

This screen allows you to create your biosketch from information you enter within your profile.

Features

- Fill out information pertaining to your Education, Employment, Publications, etc., in the appropriate submenu options.
- Select one of the Biosketch templates ([PHS398/2590], [NIH SF424] or [Create New Personal]) to create your Biosketch from the information entered.
- View the PDF, replace, edit or delete (click radio button then [Delete]) existing Biosketches.
- [Upload New] Biosketch information from existing files.
My Profile > Delegates

Overview

The Delegation menu option allows the user to delegate access to his/her items to another individual within PennERA. This function is particularly useful when the user is out of the office for a long period of time.

Features

- Select [Add] to create delegates from the PennERA community.
- From the Alpha-split list choose the name of the person you wish to grant access.
- Delegate the appropriate level of authority
  - View or Edit proposals
  - View, Edit, Add, and/or Delete items from the Calendar.
- Click [Save] to save changes.
My Profile > Education

Overview

NSF (FastLane) requires information about an investigator's highest degree and year it was awarded. This information is not required in submissions to most other agencies but can be entered if desired.

Navigate to the Education section link and click [Add New] to add a degree or click the Edit icon to change existing information.

Enter information and click [Save and Return].

Click Report to Grants.gov so that the information will populate records created.
My Profile > Resources

Overview

This section allows the user to enter Resource information directly into their profile. When creating proposals, information entered here may be used in the Resources form (if applicable). Common practice is to upload Resources information as Word documents that will be converted into PDF forms.
My Profile > Sponsor Credentials

Overview

NIH (eRA Commons), NSF (FastLane), and DOD-CDMRP proposals require certain identities in order to submit proposals. This information can be entered in this section and will be automatically populated in any proposal records created after the Profile is updated.

- Any existing credentials are listed at the bottom of the screen and may be edited. You may also add new credentials.

Select a Credential Type and enter the Credential identity; click [Save].

Click [Add New] to add another Credential Type or click the Edit icon to change existing information.
My Profile > Settings

Overview

This section allows the user to modify some display options.

Features

- **Portal Login** – Only “New” portal view is now available in PennERA.
- **Results per Page** – Choose the maximum number of items to be displayed in search results.
- **Web Portal Tabs** – By default, “My Projects”, “My Contacts” and “My Calendar” are not visible as these functions are not currently used. Users may also turn off other portal tabs they are not using.
- **Color Schemes** – Choose the browser window color scheme.
- **Click [Save]** to save any changes you make to the Settings.
Working in PennERA My Proposals

Overview

This section provides links to search for, view, and edit existing proposals and to create new proposals. It also provides access to InfoEd help.

- **Show/ List** - displays a list of all proposals for which the current user is the PI.
- **Search For** - displays various search options to locate proposals.
- **Create New Proposal** - start new records.
- **Help** - online User Guides provided by InfoEd (not Penn-specific).

**My Proposals > Show List**

Click on this link to display a list of all proposals for which the current user is the Principal Investigator.

**Features**

- The information in the results lines displayed is the same as the Sample Results presented in the Search For details (see next section).
- Mouse over the Open icon to access features to open Proposal Development in the Edit or View modes.

**My Proposals > Search For**

Click this link to display a search screen.

**Features**

- Frequently searched fields are initially displayed.
- Click on “Show Additional Search Options” to display more search fields.
- Can use wildcards (*) in most fields.
- In most text fields, there is the option to enter information or select from a picklist.
- All column headings for results may be sorted in ascending or descending order. Default sort is by Title.
- Results lines contain information about the proposal, either displayed or available in “mouseover” icons.
Sample Results

<table>
<thead>
<tr>
<th>Investigation Number</th>
<th>Title (PT)</th>
<th>Current Prime Fund #</th>
<th>Requested Period</th>
<th>Sponsor Department</th>
<th>Info</th>
</tr>
</thead>
<tbody>
<tr>
<td>10049385</td>
<td>Student On-Your-Own Subaward to Penn</td>
<td></td>
<td>01-Apr-2013 - 31-Mar-2017</td>
<td>CHILDREN'S HOSPITAL OF PHILADELPHIA</td>
<td></td>
</tr>
</tbody>
</table>
My Proposals General Features

The following are some General Features used when working in a proposal.

********************************************************************************

**Buttons, Drop Down Boxes, Links, Etc.**

*Action buttons* allow you to process within the screen. Click on the button to initiate the appropriate action.

- **Save**, an Action button, located at the top left of the screen, is only available once you are in a Proposal record and should always be used to save work done on the proposal.
- **Done**, an Action button, located at the top left of the screen, is only available once you are in a Proposal record and is used to exit the proposal.

**Radio Buttons** are for unique selections. Click on the button to select an item or answer a question.

**Drop down boxes** are for selection. To use a drop down box, move the cursor over inverted triangle and click to allow drop down selections to appear. Click to select the appropriate item.

**Links** are used to open/edit sections of the proposal, to add or remove sections, to upload attachments, etc.

********************************************************************************

**Intuitive Search** is used to locate Proposals, PI names, and staff information. Start typing the name in the box and all options appear. Highlight the desired entry and click [Select]. You may need to scroll over to find the [Select] button.

**Alpha-split lists** are used to locate Proposals, PI names, and staff information.
Select a letter; use the drop down box or search for a particular entry by typing person’s name. Highlight the desired entry and click [Select].

********************************************************************************

Upload Documents, Warnings, etc.

Upload Documents

You will be required to upload documents at various points in the Proposal Development process. Below are instructions for completing a document upload:

- Click [Browse…].
- Find the appropriate file on your computer.
- Change document name if necessary (e.g., Project Narrative for 10009452).
- Click the Upload link.

The successfully uploaded document can be Viewed or Removed.

Note: Documents uploaded to Proposal Development are stored in PDF format. View your uploaded documents to ensure special characters, figures, pictures, etc., are captured correctly.

********************************************************************************

Warning and Error message boxes

The application dynamically checks your entries and alerts you to items that are incorrectly entered or items that you fail to enter but that are required.
**Note**: Be patient when saving data or completing the form. Make sure the application has completed the last action and has finished refreshing the screen before moving to the next step.

- To edit a previously completed form, the form must be “checked out”. Select that form from the Left Sidebar Menu, click to uncheck the “Completed” box, and make edits as necessary. It will be necessary to [Save] and Complete the form again.

**************************************************************************************

**Completed**

**Completing each section of the proposal**

- As you complete each section of the Proposal, click the [Save] button in the upper left corner of the screen. This will save all data entered onto that form or page.

- After saving the data, check the box in the upper right corner “Completed”.

- A blue check mark appears next to the completed sections on the Left Sidebar Menu. This blue check mark indicates these sections or forms have been completed and “checked in” to the application.

**Note**: Be patient when saving data or completing the form. Make sure the application has completed the last action and has finished refreshing the screen before moving to the next step.

- To edit a previously completed form, the form must be “checked out”. Select that form from the Left Sidebar Menu, click to uncheck the “Completed” box, and make edits as necessary. It will be necessary to [Save] and Complete the form again.

**************************************************************************************

**Exiting a proposal record**

- When finished working with a proposal click the [Done] button on the top left of the screen.

- The Proposal Development application will allow concurrent edit access to more than one person, although in the current software version, only one person at a time can effectively edit a proposal section.

**Note**: It is very important to exit when finished working with a specific proposal so that others may gain edit access to the entire proposal.

Do not open multiple proposals at once. Work on one proposal at a time. Save and Close it before opening another proposal.

**************************************************************************************
Create New Proposal

Section Overview

The Proposal Development application will generate the appropriate forms based on the Sponsor you select. The Sidebar Menu, displayed once in a proposal, will display the forms that are needed for the type of proposal you want to create. Below is an example of how the Sidebar Menu changes based on sponsor:

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>✓ Setup Questions</td>
<td>✓ Setup Questions</td>
<td>✓ Setup Questions</td>
</tr>
<tr>
<td>✓ SF424 (R&amp;R)</td>
<td>✓ SF424 (R&amp;R)</td>
<td>Abstract</td>
</tr>
<tr>
<td>✓ Other Project Info</td>
<td>✓ Other Project Info</td>
<td>Personnel</td>
</tr>
<tr>
<td>✓ Performance Sites</td>
<td>✓ Performance Sites</td>
<td>Budget</td>
</tr>
<tr>
<td>✓ Project Summary</td>
<td>✓ Project Summary</td>
<td>✓ Budget Items</td>
</tr>
<tr>
<td>✓ Project Narrative</td>
<td>✓ Project Narrative</td>
<td>F&amp;A</td>
</tr>
<tr>
<td>✓ 525 Forms</td>
<td>✓ 525 Forms</td>
<td>Cost Sharing</td>
</tr>
<tr>
<td>✓ References Cited</td>
<td>✓ References Cited</td>
<td>Justifications</td>
</tr>
<tr>
<td>✓ Resources</td>
<td>✓ Resources</td>
<td>Versions</td>
</tr>
<tr>
<td>✓ Other Attachments</td>
<td>✓ Other Attachments</td>
<td>Budget Periods and Setups</td>
</tr>
<tr>
<td>✓ Personnel</td>
<td>✓ Personnel</td>
<td>Supporting Documents</td>
</tr>
<tr>
<td>✓ PHS398_ResearchPlan</td>
<td>✓ PHS398_ResearchPlan</td>
<td>Research Plan</td>
</tr>
<tr>
<td><strong>Budget</strong></td>
<td><strong>Budget</strong></td>
<td>Approvals</td>
</tr>
<tr>
<td>✓ Budget Items</td>
<td>✓ Budget Items</td>
<td>Internal Documents</td>
</tr>
<tr>
<td>✓ F&amp;A</td>
<td>✓ F&amp;A</td>
<td>Finalize</td>
</tr>
<tr>
<td>✓ Cost Sharing</td>
<td>✓ Cost Sharing</td>
<td></td>
</tr>
<tr>
<td>✓ Modular Budget</td>
<td>✓ Modular Budget</td>
<td></td>
</tr>
<tr>
<td>✓ Justifications</td>
<td>✓ Justifications</td>
<td></td>
</tr>
<tr>
<td>✓ Versions</td>
<td>✓ Versions</td>
<td></td>
</tr>
<tr>
<td>✓ Budget Periods and Setups</td>
<td>✓ Budget Periods and Setups</td>
<td></td>
</tr>
<tr>
<td>✓ Approvals</td>
<td>✓ Approvals</td>
<td></td>
</tr>
<tr>
<td>✓ Internal Documents</td>
<td>✓ Internal Documents</td>
<td></td>
</tr>
<tr>
<td>✓ PHS398_CoverPageSupplement</td>
<td>✓ PHS398_CoverPageSupplement</td>
<td></td>
</tr>
</tbody>
</table>

Features

- The Proposal Development application will lead you through the steps that are necessary to satisfy the requirements specified by the sponsor. The Sidebar Menu represents those defined steps. Different sponsors have different requirements. The Sidebar Menu changes based on the sponsor.
- Each submenu must be completed in order to “Finalize” the proposal, but the forms do not have to be completed in sequential order.
Process Overview

The “Create a Proposal” process consists of four basic steps, with the addition of the appropriate Sponsor-required forms:

Create a Proposal

1. Profile update
   - Verify and/or update your Profile information in PennERA (especially NIH Commons and NSF FastLane identities, name, address, city, state, country, phone, email).
   See also Profile for more information.

2. Begin preparing Word or PDF documents that will be uploaded to the proposal. Required documents will vary by sponsor and may include some or all of the following:
   - Project Summary
   - Information on use and treatment of human subjects and/or vertebrate animals
   - CVs/biosketches and/or Other Support for Key Personnel
   - Project Narrative
   - Resources
     - Facilities and Other Resources
     - Major Equipment
   - References Cited
   - Additional attachments if needed
**Note:** If your document uses a symbols or complex graphics, it is wise to convert the document to PDF format before uploading to ensure that these elements are correctly converted.
New Proposal Questionnaire - Steps 1-7

Overview

When creating a new proposal, you are prompted through a series of seven set-up questions that enable you to launch into the proposal creation process. After completing those seven steps, you will not be able to return to this form again, but you will be able to change the information on other screens.

Step 1 - Determine PI, initiate proposal creation

Features

- Change the PI
- Create a new proposal

Change PI

- The “PI” defaults to the user.
  - If creating a proposal for someone else, click the Change link next to the PI’s name.
  - Begin typing the new PI’s name, choose from the search results and click [Select].
- If you are creating a proposal for another PI, you cannot “Submit” the proposal.
- PIs must submit proposals under their name.

Create a New Proposal

- Click [Continue].
Step 1 Continued… – Find Funding Opportunity

Features

• Allows access to SPIN funding database, if necessary.

... (image of user interface)

• Select from the drop down box “Select from Grants.Gov Opportunities”.
• Click [Continue] to continue to Step 2.

Note: There is a [Back] button on each screen within the questionnaire. Use [Back] to go back one or more steps if you need to change a previous answer.

Select from Grants.Gov Opportunities

Features

• Allows search of the Grants.Gov funding database using keyword search criteria from the full program, title, or funding opportunity number.

Note: Although there are several options for locating the Funding Opportunity Announcement, the method presented here is recommended

Funding Opportunity Numbers should not be retrieved for non-S2S Federal proposal records set up as generic records.

... (image of user interface)

• Type in the search criteria. Examples:
  o Funding Opportunity Announcement Number: “parent R01”
  o Part of the Opportunity Title: “Parent R01”.
  o Can also enter keywords.
  o “S2S” is selected by default.
• Click [Search].

Wait for the screen to refresh with the program information.
• Click Select below the appropriate Opportunity Number.

Step 2 – Select New Project or Competitive Renewal

• Review the information displayed in Step 1 for the selected Program Number.
• Determine if this proposal is a New Competing or Competitive Renewal.
• Click [Continue] to continue to Step 3.

Step 3 – Select a Sponsor


• Click [Continue] to continue to Step 4.
Step 4 – Proposal Number (also called institution number)

Will be automatically numbered by the system once the set up questionnaire has been completed.

*Note:* If you are requested to manually enter a Proposal Number, please stop, click [Back] to Step 2 and repeat. If manual input is again requested, stop and send e-mail to PennERAhelp@lists.upenn.edu.

Step 5 – Enter the Proposal’s Title

- Enter the title of your proposal.
- Click [Continue] to continue to Step 6.

Step 6 – Enter Project Dates

- Enter the project dates using a MMDDYY format (e.g., “080109”; system changes date format to DD-Mon-YYYY) or select the date from the calendar tool.

*Note:* Some Proposal types validate date information based on Sponsor Mechanism Type.

- Click [Continue] to continue to Step 7.

Step 7 – Confirm Budget Periods, Create Proposal

**Features**
• Confirm the number of budget periods based on the Project Start and End dates from Step 6.

**Is all of the above information correct?**

• Review the information you entered and click [Create Proposal] to continue, the [Back] button at the top of the screen or the [Step back through responses] button at the bottom of the screen to make changes to any of the earlier steps.
• The application automatically assigns a Proposal Number (i.e., Institution Number) when you complete this step.

Please be patient while the proposal is processing. Once processed, Setup Questions page will load.
Step 8 - Setup Questions

Overview

The Setup Questions (Step 8) provide questions/answers that enable the Proposal Development application to determine and present the appropriate screens for subsequent parts of the proposal. Answer the questions based on your knowledge of the proposal. Setup questions vary by Sponsor and Mechanism Type. Many of the answers are pre-filled based on the type of funding program selected.

Features

- Subsequent forms will reflect the type of information you enter here.
- Some information is pre-entered based on the program you have chosen, but all information can be changed if the pre-entered answers do not reflect the facts about the project.
- Some information needs to be completed, see below:
### Deadline Information

**Deadline Date:** 07-Sep-2010  
**Deadline Time:** 5:00:00 PM  
**Deadline Time Zone:** (UTC-05:00) Eastern Time (US & Canada)

### General Proposal Properties

- **Will your proposal include any Subcontractors?**  
  - [ ] Yes  
  - [ ] No
- **Will your proposal involve the use of Human Subjects?**  
  - [ ] Yes  
  - [ ] No
- **Will your proposal involve the use of Laboratory Animals?**  
  - [ ] Yes  
  - [ ] No
- **Will your proposal involve multiple principal investigators?**  
  - [ ] Yes  
  - [ ] No
- **Will your proposal be a training grant?**  
  - [ ] Yes  
  - [ ] No
- **Associated Departments:**  
  - 4423 - PS Mental Health Services  
  - 4425 - PS Mental Health Services
- **PI Departments:**  
  - [ ] Add

### Because you indicated that this proposal is to PHS/NIH

- **Will this proposal involve human embryonic stem cells?**  
  - [ ] Yes  
  - [ ] No
- **Is this proposal funding a Clinical Trial?**  
  - [ ] Yes  
  - [ ] No
- **Is this proposal an NIH-defined Phase III Clinical Trial?**  
  - [ ] Yes  
  - [ ] No
- **Will this proposal be using a Modular budget?**  
  - [ ] Yes  
  - [ ] No
- **Will this proposal involve the Cumulative Inclusion Report?**  
  - [ ] Yes  
  - [ ] No

### Budget Setup Information

- **What kind of budgeting model would you like to use?**  
  - [ ] Budget by Total Project
- **Select the Program Type:**  
  - [ ] select -
- **The majority of the research will be conducted:**  
  - [ ] On Campus  
  - [ ] Off Campus

### Cost Sharing Information

- **Which department or organization will be responsible for any cost sharing on the proposal?**  
  - 4423 - PS Mental Health Services
- **Who will be responsible for project costs that might not be reimbursable/allowable by the sponsor?**  
  - 4423 - PS Mental Health Services
- **Other funding information, guidelines, or restrictions:**

1. **Submission Mechanism/Form Information**

- **Submission Mechanism/Screen Template** is pre-populated based on the type of grant.
  - If this is an application that will be directly submitted to Grants.Gov from PennERA Proposal Development (system-to-system, or S2S), the template should be a 424 R&R electronic submission.
  - If this not an S2S proposal, the template should be UPENN – Generic Template.
- In the electronic submission process, all Grants.gov proposals are considered solicited and should have a Funding Opportunity Announcement number.
  - For NIH investigator-initiated proposals, there is a parent or umbrella funding opportunity that is the equivalent of the “unsolicited” proposal in the paper submission process.
  - NIH Parent Announcements can be found at [NIH Parent FOAs](#).
  - Generic records should never have an opportunity number entered.
- Verify the correct **Opportunity Number** is present.
  - Click the **Get Opportunity** link if this number must be changed.
2. Grants.Gov Submission Information

- Information will auto-populate based on the Opportunity Number.
- Review information for accuracy and to ensure that proposals are still being accepted (Opportunity Open and Close Dates).
- Click on the Mechanism Opt In/Out link to opt out of validations that do not apply to this proposal’s requirements.

Forms are selected by the application based on the opportunity chosen and the answers to questions on this tab. These are not editable.

After all questions are answered, check this section to ensure all required forms are listed and checked as “Included”.

```
Form                      Version               Included
RR_SF424_2_0              RR_SF424_2_0-V2.0          ✓
PHS308_ResSearchPlan_2_0  PHS308_ResSearchPlan_2_0-V2.0 ✓
PHS308_CoverPageSupplement_2_0  PHS308_CoverPageSupplement_2_0-V2.0 ✓
RR_KeyPersonExpanded_2_0   RR_KeyPersonExpanded_2_0-V2.0 ✓
RR_OtherProjectInfo_1_3-V1.3 RR_OtherProjectInfo_1_3-V1.3 ✓
PerformanceSite_2_0-V2.0  PerformanceSite_2_0-V2.0 ✓
RR_SubawardBudget00_1_3-V1.3 RR_SubawardBudget00_1_3-V1.3 ✓
```
3. **Deadline Information**

- Always provide a deadline date for all proposals.
- Check pre-populated dates for accuracy. Information will auto-populate based on the Opportunity Number if this is an S2S submission.
- Information can be overwritten if necessary.
- Refer to the applicable Program Announcement to verify the submission deadline date, time, and deadline type. The Deadline Time Zone for Penn is Eastern Standard Time.

4. **General Proposal Properties**

- Answer the questions “Yes” or “No” by clicking in the appropriate radio button.
- Information in this section will drive the budget information and the need to add protocol information for human subjects or vertebrate animals.
- Add or change the default associated department (see Appendix A for more complete details).
  - The Associated Department will default to the PI’s Payroll Home Department information.
  - Adjust if this is not the administering department (i.e., responsible org).
  - Add any org for which a subaccount will be issued if the proposal is funded.
  - PI Department is not editable as this is not related to account setup.
- Proposal can be linked (for informational purposes) to an existing proposal record, if desired.

![General Proposal Properties](image)

5. **PHS/NIH Questions (if a PHS/NIH Grant)**

- Answer the questions “Yes” or “No” by clicking in the appropriate radio button.
- **Modular budget** - generally used for application requests of $250,000 or less in direct costs per year and also as required or prohibited by a specific opportunity announcement (FOA).
  - Answer “Yes” or “No” to whether or not this is a Modular budget.

![PHS/NIH Questions](image)
6. **Budget Setup Information**

- Select either **"Budget by Total Project"** or **"Budget Period by Period"** or **"424 Budgeting"**
  - **Budget Period by Period**
    - Budget expense by each period.
    - Best option if effort and/or non-personnel expense will vary in most budget periods of the project.
  - **Budget by Total Project**
    - Budget expense on a project basis
    - Best option if the only change to expenses in each budget period is primarily for inflation.
  - **424 Budgeting**
    - Primarily a data entry method
    - Does not calculate fringe benefits or inflationary increases
    - Does not evaluate for the NIH cap
    - Requires more data entry than either of the other two budget methods

- **Program Type** – select the type of project from the dropdown box
- **Indicate where the majority of the work will take place** – on or off Penn’s campus.

*Note:* This information will select the appropriate template for calculation of the F&A (Facilities & Administrative) costs for the budget.
7. Cost Sharing Information

This section can be used to change default settings for cost-sharing information. Based on the Funding Opportunity selected, information about limitations imposed by the sponsor on total project costs will also be displayed here.

- Cost Sharing defaults to the Primary Associated Department (Resp Org).
- Defaults to the PI’s Department for unreimbursable/unallowable costs.
- Different Orgs can be chosen if they are accepting these costs.
  - Click [Set] to open dropdown alpha-numeric search list to select another Org that would be responsible for cost-sharing or unreimbursable/unallowables costs.
  - Search by Org # not department name.
  - [Select] the Org that will share the expenses.
  - When you begin to enter the budget, you can enter the account numbers associated with these Orgs.

- Accept or change the answers to the additional questions regarding funding.
- Complete the information box Other funding guidelines/ restrictions/ information, if necessary, as it applies to the proposal.
  - Use this section to provide any information about Funding Opportunity Announcement numbers for generic records for non-S2S federal-sponsored proposals.

Note: Do NOT enter salary caps or annual project limitations (e.g., $250,000/year for modular budgets). All of these limitations are incorporated in the validations that Proposal Development uses to build the budget. If you plan to enter other funding caps or ceilings, please consult with the PennERA Help Desk before entering any values.

- Click [Save] when all questions have been answered. The “Completed” box is automatically checked.
Proposal Forms

Overview

You can upload many of the documents that are required for your Proposal. Other forms require you to enter the data directly into the Proposal Development application. Before you begin your entry, make sure you have the relevant information at hand for things like: resources, budget information, key people, etc.

As you proceed through the Proposal Forms, you can stop and [Save] your work at any time and return to it later. Always click on the [Done] button to exit when you are finished working on the proposal.

The Sponsor that you select for your Proposal will cause the Proposal Development application to generate the appropriate forms for that Sponsor. The Sidebar Menu on the left reflects the forms that are specific to the Sponsor you select. You must complete all the forms that your Sponsor requires before you can assemble and route your Proposal.

Although the forms vary from Sponsor to Sponsor, generally speaking, all proposals will need several forms that describe what the proposal is about, who will be doing the work, projected costs, outcomes, etc.

The following pages in this section use the SF424 (R&R) forms as required by the sponsor NIH to illustrate system features, processes, and procedures. The use of other sponsors, while displaying a different set of forms, will be processed in the same way, using the same system features, functions, and procedures.

Toolbar

Features

Unlike previous versions of PennERA, Toolbar is not available once you open or begin creating a proposal. Toolbar is available at the Portal screen and has the following functions.

• **Find Funding** – Opens a window for SPIN
• **CV Database** – Searchable access to the Penn CV database
• **Logout** – Click to exit from PennERA

Other Navigation Tools

Features

Once you have opened a proposal, all navigation occurs from either the buttons on the top left or the Sidebar Menu.

• **Done** – Click to exit the proposal record.
  Required in order to correctly exit a proposal record. Exiting (logout) PennERA does not immediately remove user from record access.
• **Save** – Proposal Development will ask you to save if needed, but click on this button if in doubt.
• **All Proposal Tabs** – Click on any tab to navigate between screens in your proposal.
• **Support** – File a help request with the PennERA Team.
• **Show Help** – Display context-sensitive help.

SF424 (R&R)
Overview

This is the face page for the application. Most of the information is derived from the Setup Questions answered by the user and administrative set-ups provided by ORS.

- Required fields, highlighted in yellow on the screen, must be answered to complete this form.
- Click the [Save] button before moving to the next step.

Remember to check Completed when finished with the form.

Most information is pre-populated.
Click on any of the yellow fields to open the form.
• Complete Section 19
  o Click in any highlighted yellow field. Scroll to the top of the new window.

  o Select the **Official Signing for Applicant Organization**. Choose the person who usually signs your proposals.

• Click [Set], wait for the information to appear, then click [Back].

To finish the form:

• Click the [Save] button, then check ☑ the **Completed** box at the top of the form. If information is missing, a pop-up will tell you what is missing and highlight it in yellow on the form.
Other Project Info

Overview

Answer questions pertaining to human subjects, vertebrate animals, etc.

Features

- The questions on this screen are brought over from the Setup Questions. If you are unable to change an entry on a particular question on this page, return to the Setup Questions (uncheck ✔ Completed on the Setup Questions) and correct the Setup Questions accordingly. Then recheck ✔ Completed.
- Answer questions as needed.
- Click the [Save] button.
- Check ✔ the Completed box at the top of the form and your information is saved.

Assurance numbers are pre-populated.
Performance Sites

Overview

Performance Sites is an editable screen where you provide information about where the research is to be performed.

Features

- Change the first site to the primary associated department address.
- Change or add additional performance sites as needed.
  - Subcontract sites will be added automatically as you add subcontracts in the budget.
  - Return to this screen when the budget is completed to enter the subcontract addresses.
- Check **the Completed box at the top of the form and your information is saved.**
Project Summary

Overview

This screen gives you the option of uploading your project summary or entering it directly into the Proposal Development application. Manual entry may be too limiting in some circumstances so it is recommended that you upload a pdf document that meets the sponsor guidelines.

Features

- Click [Browse...] to locate a document to upload.
- Find and select the document on computer (Word or PDF files) – special characters/images should be converted to PDF before upload in order to maintain document’s integrity.
- Click the Upload link to upload the document
- View the PDF file or Remove the document if necessary by clicking on the associated links.

Best Practice Hints for naming your documents on your computer

- Create separate folders on your computer for each proposal.
- Include the Proposal number in the document name.
- Include a version number or date in the file name if there are multiple versions of the same document.
- Some sponsors do not allow special characters or spaces in the document name. Refer to sponsor guidelines for requirements.
Project Narrative

Overview - Upload document screen

Features

• When you upload a document, it is a good practice to “name” the document (refer to Navigation Features for details).
• Name the narrative (use the proposal number or some other identifying feature).
• Click [Browse…]
• Find and select the document on computer (Word or PDF files) – special characters/images should be converted to PDF before upload in order to maintain document’s integrity.
• Click Upload link to upload the document
• Click the [Save] button
• Check ☑ the Completed box at the top of the form.
S2S Forms

Overview

Note: Not every project requires S2S forms, but when they are required, PennERA inserts an S2S link on the Sidebar Menu.

Features

Note: Some sponsors ask you to upload attachments (varies by sponsor), Option 1, and some use editable forms, Option 2. Follow the screens/instructions on the S2S Forms tab.

Option 1
- Click on the Edit link
- Click on [Add Attachment]
- Click on [Choose File]
- Find and select the document on computer (Word or PDF files) - special characters/images should be converted to PDF before upload in order to maintain document’s integrity.
- Click the [Upload] button to upload the document and click PDF icon
- Click the [Save] button
- Check the Completed box at the top of the form
- Click on [Done] to close the window
**Option 2**
- Click on the **Edit** link. The sponsor’s form opens in a new window.
- Complete all field highlighted in yellow.
- Click the **[Save]** button.
- Check the **Completed** box at the top of the form.
- Click on **[Done]** to close the window.

This report format should NOT be used for collecting data from study participants.
References Cited

Overview - Upload document screen

Features

- Click **[Browse...]**
- Find and select the document on computer (Word or PDF files) - special characters/images should be converted to PDF before upload in order to maintain document’s integrity.
- Click **Upload** link to upload the document
- Click the **[Save]** button
- Check ✓ the **Completed** box at the top of the form.
Resources

Overview

This is where the resources available, “Facilities & Other Resources” and “Major Equipment” to the project are entered. This page provides the option of uploading an existing document, selecting information from the database, or manually entering information.

Note: Due to number of character limitations, it is highly recommended that project resources be uploaded as a document and not selected from the database or manually entered.

Features

- Upload of “Facilities and Other Resources” and “Major Equipment” documents must be completed.
- Click [Browse...] under “Facilities and Other Resources” to locate a document to upload.
- Find and select the document on computer (Word or PDF files) – special characters/images should be converted to PDF before upload in order to maintain document’s integrity.
- Click the Upload link to upload the document
- View the PDF file or remove the document if necessary
- Repeat the previous steps to upload “Major Equipment” documents.
- Click [Save] button
- Check Completed box at the top of the form.
- Click on [Browse...] under “Major Equipment” and follow the same steps.

Note: Use the Database – information can be uploaded from the Profile database or manually entered but characters/spacing is limited.
Other Attachments

Overview

Upload any additional documents that need to be sent to the sponsor such as previous correspondence with the sponsor or materials specified by the sponsor in the Program Announcement.

Note: Be sure to review the sponsor’s instructions. Many sponsors limit what may be uploaded this tab or provide other detailed instructions about special uploads.

Features

• This is the only form that does not have to be completed (blue check beside it) in order to finalize the proposal.
• Good business practice to check “Completed” on all of the forms as a way to verify that you have intentionally not attached a document here.
• If there are forms to be added, Click [Browse...]
• Find and select the document on computer (Word or PDF files) – special characters/images should be converted to PDF before upload in order to maintain document’s integrity.
• Click Upload icon to upload the document
• View the PDF file or remove the document if necessary
• Click the [Save] button
• Check ☑ the Completed box at the top of the form.
Personnel (Upload Biosketch)

Overview

All Key Personnel require a CV to be added to the proposal. Enter budget information first and this screen will populate with Key and Non-Key Personnel information (and Other Significant Contributors for NIH proposals). Key Personnel are listed as PI first then in alpha order but the information can be “ordered” as you prefer. Current and Pending Support information can be added to the proposal.

**Note:** Follow sponsor instructions about uploading biosketches for Non-Key Personnel. In some instances, these may not be retrieved electronically by the sponsor upon submission. Determine which documents are mandatory, optional, or not required. “Not required” documents generally should NOT be uploaded.

- Click the **Get** link in the CV Req column to initiate upload. If the **Get** link is not available for Personnel who are Penn staff, click the empty box in the CV Req column and the **Get** link will appear.
Features

- This opens a window where you upload the CV.
- There are 2 ways to upload a CV.

  **If your personnel has a CV stored** against their user profile, select the CV from the dropdown below “Use Existing CV/Biosketch stored against user profile” on the right side of the screen.
  - Click [Select].

  **If your personnel does not have a CV stored** against their user profile, click [Browse...].
  - Find and select the document on computer (Word or PDF files) – special characters/images should be converted to PDF before upload in order to maintain document's integrity.
  - Click the **Upload** link to upload the CV

- Regardless of the option you use, the application closes the window and uploads the CV once you have selected the CV.
- Fill-in **Administrative Contact** information.
- Check **✓** the **Completed** box at the top of the form.
PHS 398 Cover Page

Overview

Cover page for the proposal which includes information about the project and the University’s Organizational information.

- Select PHS 398 Cover Page

### Features

- Contains information from previously entered screens.
- Verify information – should be accurate based on Profile page.
- Add any additional information (Degree and County Information are required fields).
- Click [Save] button.
- Check the Completed box at the top of the form.

### Form Fields

1. **Project Director / Principal Investigator (PD/PI) Change**
   
   - First Name: STEPHEN
   - Middle Name:
   - Last Name: FRATIMARO
   - Suffix:

2. **Human Subjects**
   
   - Clinical Trial: [No] [Yes]
   - Agent-Defined Mode III Clinical Trial: [No] [Yes]

3. **Disclosure Permission Statement**
   
   If the application does not result in an award, is the Government permitted to disclose the title of your proposed project, and the name, address, telephone number and e-mail address of the official signing for the applicant organization, to organizations that may be interested in contacting you for further information (e.g., potential collaborations, investments)?

   - [Yes] [No]

4. **Program Income**
   
   All applications must indicate whether program income is anticipated during the period(s) for which grant support is requested. If program income is anticipated, use the format below to reflect the amount and source(s).

<table>
<thead>
<tr>
<th>Budget Period</th>
<th>Anticipated Amount</th>
<th>Source(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 year</td>
<td>$</td>
<td></td>
</tr>
<tr>
<td>2 year</td>
<td>$</td>
<td></td>
</tr>
</tbody>
</table>

5. **Human Embryonic Stem Cells**

   - Includes the same project involves human embryonic stem cells? [No] [Yes]
   
   If the proposed project involves human embryonic stem cells, list below the registration number of the specific cell line(s) from the following list. [http://stemcells.nih.gov/research/registry/]

   - Specific stem cell line cannot be referenced at this time. One from the registry will be used.

<table>
<thead>
<tr>
<th>Cell Line</th>
<th>Sequence</th>
<th>Delete</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

6. **Inventions and Patents (For renewal applications only)**

   - Inventions and Patents: [Yes] [No]

7. **Change of Investigator / Change of Institution Questions**

   - Change of principal investigator / program director
   - Change of Grantee Institution

---

59
**PHS 398 Research Plan**

**Overview**

This is the screen that requires you to upload the separate sections of the technical component of the research proposal.

- Select **PHS 398 Research Plan** from the **Sidebar Menu**

**Features**

- The type and number of forms to be uploaded is dependent on the answers on the Setup Questions form – review the form carefully to determine which documents need to be uploaded to the proposal.
- Upload each form following the upload steps previously described.
- As you upload each section, the Proposal Development application returns the document as a PDF, shows the page count for the upload, and the total page count for the Proposal.
- **Follow the sponsor’s guidelines to ensure that basic required sections are uploaded.**
- Additional documents may be required based on the use of human and/or vertebrate subjects, subcontractors, etc. Use the link at the bottom of the screen, **Add New Document**. This opens a window to add the documents.
- Click [Save] icon
- Check  ✔ the **Completed** box at the top of the form.

The application allows you to label the research plan as either **draft version** or **final version**. A research plan labeled as “draft” must be changed to “final” before it can be approved and submitted by ORS.
Note: To allow investigators as much time as possible, proposals may be submitted for internal review with Draft Version selected. However, Grants.Gov requires the proposal to be submitted with Final Version. The Office of Research Services is unable to submit a Draft Version to Grants.Gov. It is the responsibility of the Principal Investigator to submit a Final Version proposal in accordance with Penn’s internal submission deadlines to ensure the proposal is submitted in accordance with the sponsoring agency’s posted submission deadline.
Budget

Overview

The Budget section has a sub-menu that lists all the forms related to the budget. In general:

- There are three types of Budget Items: personnel costs, non-personnel costs and subcontractor costs (which consist of personnel costs and non-personnel costs).
- There are 2 Personnel Types that can be used to identify the personnel: Key Personnel and Non-Key Personnel. In the new PennERA portal, if someone is a significant contributor, their personnel type will be Key Personnel, their role on the project will be “Other” and type in “Significant Contributor.” See Add Additional Personnel for Details.

Click on “Budget” on the Sidebar Menu to open the Budget sub-menu. Several steps are required to enter the necessary budget data. The tabs vary for Detailed, Modular and Summary Budgets.

Features

- The budget sub-menu items Budget Items, F&A, Cost Sharing and Modular Budget (if required) must be entered in the order in which they appear.
- Budget Periods and Setups -- Use form to add or delete budget years, change budget type/dates and/or the PI information. This information is completed with information from the other budget sub-forms, but the form can be completed first if information needs to be added, deleted and/or changed.
- Multiple budget periods can be entered at one time.
- Various versions of the budget can be created for comparison purposes.

Note: The sections “Versions” and “Budget Periods & Setup” are not required sections and can be viewed at any time. However, to edit these forms, the other tabs (Budget Items, F&A, Cost Sharing, etc.) should not be marked “Completed”.

Note: The example in the following pages is for a “Period by Period”, modular budget, if you use a “Project” budget and/or a non-modular budget, there will be slight differences in the screens but the process is the same (see Appendix A for information on “Budget by Period” budget).
Summary Budget

Overview

When a Summary Budget is present, the summary tables on the Summary Budget screen are editable for direct data entry. See screen shot on the following page. The Summary Budget populates the Request Estimated Funding section of the SF424.

Features

- There are only two budget sub-menu items: Budget Justifications and Budget Periods and Setups. See descriptions of these sections on subsequent pages of this guide.
- For Summary Budgets, do not upload anything to Budget Justifications.
- There is no need to access the Budget Periods and Setups tab or to mark it Completed.
- Total Direct Costs are entered on “Other Costs” line in the Sponsor Budget Summary for funds requested from the sponsor for each budget period.
- Requested F&A is entered on “Indirect Costs” line in Sponsor Budget Summary for each budget period.
- Institution Budget Summary direct costs are entered if cost-sharing is proposed.
- The totals on this screen are used to populate the Estimated Funding section of the SF424 and also populate information in the Proposal Tracking record which will be used if the project is funded.
- Check the Completed box at the top of the form.
### PROJECT BUDGET SUMMARY

<table>
<thead>
<tr>
<th>Period</th>
<th>Start</th>
<th>End</th>
<th>Directs</th>
<th>Indirect</th>
<th>Project Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 PT Vw</td>
<td>01-Jul 2015</td>
<td>30-Jun 2015</td>
<td>$83,290.00</td>
<td>$55,950.00</td>
<td>$149,240.00</td>
</tr>
<tr>
<td>2 PT Vw</td>
<td>01-Jul 2016</td>
<td>30-Jun 2017</td>
<td>$90,936.00</td>
<td>$64,536.00</td>
<td>$155,472.00</td>
</tr>
<tr>
<td></td>
<td>01-Jul 2015</td>
<td>30-Jun 2017</td>
<td>$184,146.00</td>
<td>$155,486.00</td>
<td>$294,636.00</td>
</tr>
</tbody>
</table>

### SPONSOR BUDGET SUMMARY: NATIONAL INSTITUTES OF HEALTH

<table>
<thead>
<tr>
<th>Budget Category</th>
<th>Period 1</th>
<th>Period 2</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Labor</td>
<td>$61,900.00</td>
<td>$61,800.00</td>
<td>$123,700.00</td>
</tr>
<tr>
<td>Subcontractor Totals</td>
<td>10,350.00</td>
<td>10,661.00</td>
<td>21,011.00</td>
</tr>
<tr>
<td>Supplies</td>
<td>15,000.00</td>
<td>16,300.00</td>
<td>25,300.00</td>
</tr>
<tr>
<td>Indirect Costs</td>
<td>55,940.00</td>
<td>54,536.00</td>
<td>110,480.00</td>
</tr>
<tr>
<td></td>
<td>$149,200.00</td>
<td>$145,436.00</td>
<td>$294,636.00</td>
</tr>
</tbody>
</table>

### INSTITUTION BUDGET SUMMARY: 4423 - PS-MENTAL HEALTH SERVICES

<table>
<thead>
<tr>
<th>Budget Category</th>
<th>Period 1</th>
<th>Period 2</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Labor</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Subcontractor Totals</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Supplies</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Indirect Costs</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td></td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>

### INSTITUTION BUDGET SUMMARY: CHILDREN'S HOSPITAL OF PHILADELPHIA

<table>
<thead>
<tr>
<th>Budget Category</th>
<th>Period 1</th>
<th>Period 2</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Labor</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Subcontractor Totals</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Supplies</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Indirect Costs</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td></td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>

### INSTITUTION BUDGET SUMMARY: 4423 - PS-MENTAL HEALTH SERVICES

<table>
<thead>
<tr>
<th>Budget Category</th>
<th>Period 1</th>
<th>Period 2</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Labor</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Subcontractor Totals</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Supplies</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Indirect Costs</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td></td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>
Totals from the data entry are used to populate the SF424.
Budget > Budget Items

Overview

This section allows you to enter specific budget information (personnel, non-personnel expenses and sub-contracts if appropriate). It is not present in a Summary Budget record.

Features

• In the Personnel Costs section the PI name/Role information is already available. Click the **Budget** link next to the budget line item to open that line and make the proper adjustments.
• Add expense lines (Personnel and Non-Personnel Costs) by selecting the **Add** link in the appropriate budget section.
• The expense type “Subcontractors” is dependent on the answers given on the Setup Questions form. “Subcontractors” line item will not be available if the Setup Question (Step 8) is answered “No”.
• As budget items are added, a **Budget** link will appear to the left of the line item. Click the link to view/update the corresponding budget line item.

Salary Information - Principal Investigator

Overview

This screen allows you to enter salary, benefits, and effort for the PI on the proposal. Budget information sheets for other individuals included on the proposal will have a similar format.
1. **Salary/ Payroll Information**
   
a. Select the appointment type from the dropdown: Calendar, Academic, or Summer and type in number of months.
   
b. Type in Base Salary and select payment type: per appointment; per hour; per week.
   
c. Select Fringe Benefits type: None, Full-time federal; Full-time non-federal; or Part-time (amount will auto-populate).
   
d. Select how the salary should be applied.
      i. Continue Salary past Appointment end date – salary will continue to end of grant
      ii. Recycle Salary on the Annual Anniversary – typically used for SUMM/ACAD appointments
      iii. Salary ends on the Appointment date – appointment end date = salary end date
   
e. Select inflation type: Cost of Living of 3% is standard for University of Pennsylvania.
   
f. Leave the “Apply Inflation on the Primary Appointment Anniversary Date” unchecked – Penn does not use inflation adjustments based on appointment dates.
2. **Project Responsibilities** – Budget Justification information will be added as an uploaded work or PDF document.

3. **Time and Effort Levels on Project** – Enter the percentage of effort the staff member will be exerting on this project in each period

*Note:* For grants.gov proposals, Proposal Development will convert to Calendar Months

- Click [*Save*] button when all effected periods are complete
- Click [*Click to Add Next Person to the Proposal*] in the upper right to add additional staff to the proposal

**Add Additional Personnel**

*Note:* Adding personnel to the budget will also add them to **Personnel** tab.

**Overview**

This screen allows you to add existing Penn personnel or new staff to the proposal.

**Features**

- Use the Alpha Split drop down menu to select the Penn staff/student name
- Select Position type of the staff/student from drop down box (faculty, fellow, student, etc.)
- Select the Personnel Type, i.e. role this person will perform on this proposal (Key Personnel, Non-Key Personnel, or Significant Contributor)
- Type in the amount of effort (where 1 = 1% effort) this person will contribute
- Verify the period information is correct and change if necessary
Budget detail may be added now, or you can continue adding personnel without saving or making any changes in this Budget Detail screen.

- Add Appointment and Salary information, Fringe benefit type, Salary calculation type, and Inflation rate
- Project Responsibilities – choose Personnel Type and Role on Project from drop down box selection (Budget Justification information will be added as a word/PDF uploaded document).

Effort information should be included from information typed on the previous screen but can be changed if necessary.

- Click the **Save** button.

**Add New Staff (non-contract personnel)**

- Click **Add** and scroll down to the bottom section, Add new staff

Overview – This screen allows you to add new staff, not in the existing staff database, to the proposal (do not use for contractual personnel); usually staff that has not yet been hired, an unnamed staff member, or multiple students/graduate students.

**Features**

- Add staff that have not yet been identified
- Type **“TBD”** in the blank next to First Name
- Select the Position type (faculty, fellow, student, etc.)
- Complete the Effort information (where 1 = 1% effort)
- Click **Add as Non Key Personnel**
Budget detail may be added now, or you can continue adding personnel without saving or making any changes in this Budget Detail screen.

1. Add Appointment and Salary information, Fringe benefit type, Salary calculation type, and Inflation rate
2. Project Responsibilities – choose Personnel Type and Role on Project from drop down box selection (Budget Justification information will be added as an uploaded word or PDF document).

Effort information should be included from information typed on the previous screen but can be changed if necessary.

- Click the [Save] button
• To change Personnel Costs to a specific person.
  o Click the **Budget** link to the left of that line item.
  o Click on **[Show Details]** in the Salary/Payroll information section
  o Click **[Edit Section]** and make appropriate changes
• Click **[Save]** button.
When all staff information has been added, click **Budget Items** to add non-personnel budget information.

**Non-Personnel Expenses**

**Overview**

This screen allows you to enter non-personnel expenses such as travel, supplies, etc.

- Click **[Add]** to add Non-Personnel Costs

**Features**

- **Description** - type a descriptive label for the expense.
- **Budget/Charge Category** - choose expense category type from dropdown list.
- **Annual Inflation** - Cost of Living 3%.
- **Budget Justification** - leave blank, information will be added as a word or PDF upload.
- **Purchase/Usage Schedule**
  - **Units/Quantity**: 1 can be added in each period where there will be an annual expense
  - **Price/Charge Each**: Amount per period where there will be an annual expense
  - **Multiple Units/Quantities with corresponding prices** can be used if that is appropriate
- **Click the **[Save]** button.
  - If you have additional Non-Personnel costs, follow the next set of instructions.
  - If you do not have additional Non-Personnel costs, Click **Budget > Budget Items** on the **Sidebar Menu**.
Budget Detail

- Click [Click to add next item] to add next non-personnel budget item to create additional budget lines.
- When all budget items, Personnel and Non-Personnel have been added and saved, click Budget > Budget Items on the Sidebar Menu.
- Check the Completed box at the top of the Budget Items form.

Select Budget > F&A on the left sidebar to view system calculated Facilities & Administrative costs.

If you do not have Subcontracts, skip the next section and continue at Budget > F&A (Facilities & Administrative Costs).

Subcontractor Information

Overview

Addition of subcontractor information requires the selection of the subcontractor and the creation of the budget to be used by the subcontractor. The new portal added the ability to import the subcontract. Use this function when you receive a Subcontract R&R Budget from the subcontractor.

Features

- From the Budget Items screen, Select Add to add subcontractors and all details or Import (see next page) if the subcontractor completed the SF424 form and it is ready to import.
- Select the first letter of the subcontractor’s name from the alpha-split list and then find the specific organization from the dropdown list.
Note: If the subcontractor to be added to this project is not listed, please send an e-mail to PennERA Help pennerahelp@pobox.upenn.edu.

- Click [Select] to open the Subcontractor PI list.
- Select the subcontractor PI name from the alpha dropdown box or enter Subcontractor PI information for someone not in the dropdown (make sure all fields are completed).
- Click [Select] or [Add New] and the screen refreshes, adds the Subcontracting organization and returns you to the Budget Items screen.

• Click the Open link that appears on the right under “Detail Budgeting”. Do not use the Open link on the left under “Short Form.”

SUBCONTRACTORS

- Subcontract for Institution #XXXXXX is the University of Pennsylvania’s proposal number.
- The Proposal number on this page is for the subcontracting institution.
- Add Personnel and Non-Personnel Costs for the Subcontractor using the steps described earlier.
- Differences between Penn budget information and Subcontractor budget information:
  o Fringe benefit amounts for salaries must be added manually.
  o F&A must be added manually.
- Add F&A information manually under each Period.
- Click [Save].
- Click [Done] to finish with Subcontractor’s budget
- Check the Completed box at the top of the form to finish the Budget Items form.
- Check the Completed box to finish the Cost Sharing form.
- Check the Completed box to finish the Justifications form.
- Click [Done].
- On the Proposal’s Budget Items tab, check the Completed box to finish the Budget Items form.

If the subcontractor completed the SF424 form click the Import link.
Select the subcontracting institution from the alpha-split list.
- Click [Select].
- Select the subcontractor PI name from the alpha dropdown box or enter Subcontractor PI information for someone not in the dropdown (make sure all fields are completed).
- Click [Select].
- Click on [Browse...] and select the Subcontract R&R Budget.
- Click on [Upload].

- Click on each budget period to copy.
- You may change the PI or the Department using the dropdowns.
- Click [Process].
- The application returns to Budget Items and the uploaded information is included.
- All fields are editable by clicking on the Open link that appears on the right under “Detail Budgeting”.
- Click [Save].
- Click [Done] to finish with Subcontractor’s budget.
- Check the Completed box to finish the Budget Items form.
- Check the Completed box to finish the Cost Sharing form.
- Check the Completed box to finish the Justifications form.
- Click [Done].
- On the Proposal’s Budget Items tab, check the Completed box to finish the Budget Items form.
Budget > F&A (Facilities & Administrative Costs)

Overview

This screen shows the calculated Facilities & Administrative (F&A) expense on a line-by-line basis. It is not present in a Summary Budget record.

| Facilities and Administration Costs | | |
|------------------------------------|-----------------|
| Sponsor Calculation Method          | Auto (prefixed schemes) [ ]          |
| Institution Base Target Scheme Show| $217,154.72 Research On Campus Scheme |
| Scheme Show                        | $217,154.72 |

| PERSONNEL COSTS | | |
|-----------------|-----------------|
|                  | Period 1 | Period 2 | Total |
| FRANKOWSKI, STEPHEN | 6,650.00 | 6,790.00 | 13,440.00 |
| Sponsors Directs    | 6,650.00 | 6,790.00 | 13,440.00 |
| Sponsors F&A Base   | 3,940.00  | 4,078.00 | 8,018.00  |
| Requested F&A       | 38,886.69 | 38,886.69 | 77,773.38 |
| ARBON, ALYSON       | 38,886.69 | 38,886.69 | 77,773.38 |
| Sponsors Directs    | 21,999.99 | 21,999.99 | 43,999.98 |
| Sponsors F&A Base   | 136,905.98 | 136,905.98 | 273,811.96 |
| Requested F&A       | 70,000.00 | 70,000.00 | 140,000.00 |
| BITTNER, JULIE      | 103,517.77 | 103,517.77 | 207,035.54 |
| Sponsors Directs    | 73,000.00 | 73,000.00 | 146,000.00 |
| Sponsors F&A Base   | 22,435.40  | 22,435.40 | 44,870.80  |
| Requested F&A       | 41,215.40  | 41,215.40 | 82,430.80  |
| TSO, Grant Student  | 10,750.00  | 10,750.00 | 21,500.00  |
| Sponsors F&A Base   | 35,000.00  | 35,000.00 | 70,000.00  |

| NON-PERSONNEL COSTS | | |
|---------------------|-----------------|
|                     | Period 1 | Period 2 | Total |
| Equipment (Purchased) | 10,000.00 | 5,190.00 | 15,190.00 |
| Sponsors Directs    | 0.00      | 0.00      | 0.00      |
| Sponsors F&A Base   | 0.00      | 0.00      | 0.00      |
| Requested F&A       | 0.00      | 0.00      | 0.00      |
| Supplies            | 15,000.00 | 15,450.00 | 30,450.00 |
| Sponsors Directs    | 15,000.00 | 15,450.00 | 30,450.00 |
| Sponsors F&A Base   | 15,450.00 | 15,450.00 | 30,900.00 |
| Requested F&A       | 10,000.00 | 10,270.00 | 20,270.00 |
| Directs & F&A Total | $ 34,000.00 | $ 29,970.00 | $ 63,970.00 |

| SUBCONTRACTORS | | |
|----------------|-----------------|
|                 | Period 1 | Period 2 | Total |
| CHILDREN'S HOSPITAL OF PHILADELPHIA | 10,050.00 | 19,061.00 | 29,111.00 |
| Sponsors Directs    | 10,050.00 | 19,061.00 | 29,111.00 |
| Sponsors F&A Base   | 10,050.00 | 19,061.00 | 29,111.00 |
| Requested F&A       | 6,219.00  | 6,219.00  | 12,438.00 |
| Directs & F&A Total | $ 16,069.00 | $ 17,081.00 | $ 33,150.00 |

| Direct Cost Totals | $ 119,910.03 | $ 232,817.06 | $ 352,727.09 |
| F&A Base Totals** | $ 129,910.03 | $ 232,817.06 | $ 361,727.09 |
| F&A Totals         | $ 177,940.03 | $ 332,634.06 | $ 500,574.09 |
| Grand Totals       | $ 217,860.01 | $ 360,632.06 | $ 578,492.07 |

Features

- The negotiated F&A rates have been pre-defined in the application (see Setup Questions: Budget Setup Information Section).
- Calculation of F&A for Non-Personnel expenses is determined by the Category chosen.
• **Sponsor Calculation Method** – select the method of calculation from the dropdown box
• **Scheme** – defined in Setup Questions: Budget Setup Information Section
• Click [Save].
• Check ☑ the **Completed** box at the top of the form.
• Select **Budget > Cost Sharing**

*Note:* Category selection of Non-Personnel expense items determines whether F&A will be calculated or not. Categories exempt from F&A include: Alternations & Renovations; Inpatient Costs and Outpatient costs; Participant – Stipends; Participant – Tuition; and Equipment (Purchased); Tuition (Research Projects).
Budget > Cost Sharing

**NOTE:** Users are encouraged to contact the PennERA Help Desk for assistance when an application has cost-sharing. The information below is intended as general guidance and may not strictly fit every situation.

**Overview**

This screen allows you to view, edit or enter Cost Sharing data for a project. It is not present in a Summary Budget record.
### Non-Personnel Costs

<table>
<thead>
<tr>
<th></th>
<th>Period 1</th>
<th>Period 2</th>
<th>Line Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Equipment (Purchased)</td>
<td>18,000.00</td>
<td>6,150.00</td>
<td>16,150.00</td>
</tr>
<tr>
<td></td>
<td>18,000.03</td>
<td>6,150.00</td>
<td>16,150.00</td>
</tr>
<tr>
<td>Inst</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Cash</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>CHILD</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Cash</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Unavail</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Cash</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Supplies</td>
<td>15,800.00</td>
<td>15,400.00</td>
<td>31,200.00</td>
</tr>
<tr>
<td></td>
<td>15,800.00</td>
<td>15,400.00</td>
<td>31,200.00</td>
</tr>
<tr>
<td>Inst</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Cash</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>CHILD</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Cash</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Unavail</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Cash</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td>$23,800.00</td>
<td>$20,550.00</td>
<td>$44,350.00</td>
</tr>
</tbody>
</table>

### Subcontractors

<table>
<thead>
<tr>
<th></th>
<th>Period 1</th>
<th>Period 2</th>
<th>Line Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>CHILDREN'S HOSPITAL OF PHILADELPHIA</td>
<td>10,390.00</td>
<td>10,390.00</td>
<td>21,590.00</td>
</tr>
<tr>
<td></td>
<td>10,390.00</td>
<td>10,390.00</td>
<td>21,590.00</td>
</tr>
<tr>
<td>Inst</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Cash</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>CHILD</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Cash</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Unavail</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Cash</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td>$10,390.00</td>
<td>$10,390.00</td>
<td>$21,590.00</td>
</tr>
</tbody>
</table>

### Indirect Costs

<table>
<thead>
<tr>
<th></th>
<th>Period 1</th>
<th>Period 2</th>
<th>Line Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Direct Costs</td>
<td>77,940.98</td>
<td>139,204.60</td>
<td>217,145.57</td>
</tr>
<tr>
<td></td>
<td>77,940.58</td>
<td>139,204.03</td>
<td>217,144.58</td>
</tr>
<tr>
<td>Inst</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Cash</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>CHILD</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Cash</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Unavail</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Cash</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td>$77,940.98</td>
<td>$139,204.00</td>
<td>$217,145.57</td>
</tr>
</tbody>
</table>

### TOTAL

<table>
<thead>
<tr>
<th></th>
<th>Period 1</th>
<th>Period 2</th>
<th>Line Total</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>$183,684.56</td>
<td>$257,398.65</td>
<td>$441,083.21</td>
</tr>
<tr>
<td>Inst</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
<tr>
<td>CHILD</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
<tr>
<td>Unavail</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
<tr>
<td>Final</td>
<td>$183,684.56</td>
<td>$257,398.65</td>
<td>$441,083.21</td>
</tr>
</tbody>
</table>

### Features

- Cost Sharing sources default to the sponsor and the associated department.
- Additional cost sharing sources are added by PennERA if there are subcontracts.
• All project expense, including the cost-sharing expense, should be first entered in the Budget Items tab.
• Cost sharing should be entered on the Cost Sharing tab against the appropriate source for each cost-shared expense.
• Check the Completed box at the top of the form when finished.
• After completing this section, select Budget > Justifications (or Budget > Modular Budget if this is a modular budget).

Example

Cost-sharing is proposed in this example for half of the expense of the lab supplies.

• Enter total project costs on Budget Items tab.
• Adjust Sponsors F&A Base and Requested F&A on the F&A tab.
• Adjust funds sources on Cost Sharing tab.

NOTE: Cost-sharing of F&A is generally not calculated.

Enter the full project cost of the items to be cost-shared in Budget Items, including the amount proposed for cost-sharing.

Enter the amount requested from the sponsor for the cost-shared item on the Sponsors F&A Base.

Enter the Requested F&A.
On the Cost Sharing tab, distribute the expense between the Sponsor and the cost-sharing source, in this case, Inst, which is Penn. Identify if cost-sharing is Voluntary or Mandatory.

Click on Save CS Data to save your cost-sharing data entries.
Budget > Modular Budget

Overview

This screen summarizes the number of modules you are requesting when using the modular budget format. It is not present in a Summary Budget record.

Features

- Generally speaking, keep number of modules consistent unless equipment is being bought or some other large expense is occurring in one year vs. another year.
- Modules are set up in $25,000 increments, usually with no more than 10 modules per year.
- Change or accept Direct Modules and/or F&A Basis Modules as necessary.
- Click [Save].
- Check the Completed box at the top of the form.
- Select Budget > Justifications.
Budget > Justifications

Overview

This screen allows you to upload a form or create and edit budget justifications for each budget item entered. Although manual data entry is possible, the PennERA Team recommends uploading a budget justification in the form of a Word or Adobe Acrobat document.

**NOTE:** While this tab is present in Summary Budget records, the federal sponsor will not electronically retrieve any document uploaded to this screen. Users should not upload any document here. Check the sponsor’s instructions for the proper location for a narrative budget justification, if any is required. If an internal budget justification is provided for internal review, upload to the Internal Documents tab.

**Features**

- Upload Budget Justifications
- Click **[Browse...]** under “Personnel Justification.”
- Select Word or PDF document.
- Click the **Upload** link.
- You now have a file you can View or Remove.
- Repeat the above steps to upload “Consortium Justification.”
- Check **☑** the **Completed** box at the top of the form.
Budget > Budget Versions

Overview

This screen allows the user to save an existing budget as one version, then make changes and save as another version for comparison purposes. It is not present in a Summary Budget record.

- Select Budget > Versions if you would like to compare multiple budget possibilities in your proposal (this section does not need to be completed to “Finalize” the proposal).
- There are 2 options for comparing versions. Downloading the budget into Excel or comparing them in the application.

Features

- Option 1 - Excel
  - Click “Download” icon to download .saved budgets into Excel spreadsheets.
  - In the pop-up, click [OK] to open in Excel.

- Option 2 – in the application
  - Click [Add New Version] to copy the initial version of the budget and create duplicate(s). You may make multiple versions.
  - Type in a Version Name and Click [Save].

  - Note new budget (Budget 2) is the “Active” budget.
  - Click File Folder icon make changes to the second version of the budget.
  - Click Save icon.
  - Check “Completed” box.

Remember this is not a mandatory form for completion of the proposal.
Budget > Budget Periods and Setups

Overview

Summarization of Budget information entered for the proposal
- Select Budget > Budget Periods and Settings

Features
- This form allows changes to the budget period and setup as well as changing the PI.
- If any budget information (Budget Items, F&A, etc.) has been completed, no changes can be made to this form.
- To edit information on this page, un-complete the associated screen.
Budget > Exporting a Penn Budget to Adobe R&R Budget Form

Overview

For projects where Penn is a subcontract recipient, users can export their PD-created Penn budget (if entered in detail, using the generic template) to an Adobe R&R budget form. This form can then be sent to our sponsor for use in their budget preparation and proposal submission.

Note: The exported Adobe Budget form is only useful on projects where we are active on all periods of the prime proposal.

Features

- Provides accurate and complete budget information for Penn’s sponsor to upload to their Adobe package or import into an InfoEd proposal record if they use the InfoEd system for proposal submissions.
- Eliminates the need to “duplicate” budget information to be sent to Penn’s sponsor.
- No additional Excel workbooks or PDFs need to be created for our sponsor.

- Enter all appropriate detailed budget data and complete the proposal budget pages.
- Select [Export to Adobe].
- Search for the relevant opportunity and [Export].
- A new Adobe 424 R&R Subaward Budget file generates with all entered budget information.
- Download and send file to sponsor.

### RESEARCH & RELATED BUDGET - Budget Period 1

**Organizational DUNS:** 80000001005

**Enter name of Organization:** The Trustees of the University of Pennsylvania

**Budget Type:** Project

**Budget Period:** 1

**Start Date:** 04/01/2014

**End Date:** 07/31/2014

#### A. Senior/Key Person

<table>
<thead>
<tr>
<th>Profile</th>
<th>First</th>
<th>Middle</th>
<th>Last</th>
<th>Suffix</th>
<th>Base Salary ($)</th>
<th>Col. Acct.</th>
<th>Sum.</th>
<th>Requested Salary ($)</th>
<th>Fringe Benefits ($)</th>
<th>Funds Requested ($)</th>
</tr>
</thead>
<tbody>
<tr>
<td>X</td>
<td>CHRISTIAN</td>
<td>BTD</td>
<td></td>
<td></td>
<td>85,000.00</td>
<td>1.00</td>
<td>14,290.00</td>
<td>6,480.00</td>
<td>25,810.00</td>
<td></td>
</tr>
</tbody>
</table>

**Project Role:** Co-Investigator

#### B. Other Personnel

<table>
<thead>
<tr>
<th>Number of Personnel</th>
<th>Project Role</th>
<th>Months qualifier</th>
<th>Requested Salary ($)</th>
<th>Fringe Benefits ($)</th>
<th>Funds Requested ($)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Post Doctoral Associates</td>
<td>6.00</td>
<td>22,500.00</td>
<td>7,200.00</td>
<td>29,700.00</td>
</tr>
</tbody>
</table>

**Add Additional Personnel**

**Total Number Other Personnel**

**Total Salary, Wages and Fringe Benefits (A+B)**

**Total Other Personnel**

87
Approvals

Overview

Section to upload specific approvals for protocols such as human subjects or lab animals

- Click [Add] to open Add/Edit Approvals box.

- Select the Type from the dropdown.
- Click [Continue].
- From the dropdown box select the status of the protocol.

- Complete other known information
- Click [Save] button.
- Check ☑ the Completed box at the top of the form.
Internal Documents

Overview

This screen permits upload of internal documents for which there are no appropriate locations on the application tabs. It also contains the Proposal Transmittal and the PI Certification e-forms.

Important Note: The PI Certification and the Proposal Transmittal forms should not be completed until the proposal is ready for internal review and approval. This is a compliance issue in that the PI and the BA are attesting to the accuracy and completeness of the proposal information.

Features

- Click on the Edit icon for each e-form.
- The form will open in Edit mode.
- Check information for accuracy.
- Answer questions by clicking appropriate boxes. A red * means you must answer the question.
- Upload any internal documents required by your School or Department or by ORS or which would be helpful to the internal review process.
- Check the “Completed” box which will save, lock the form and close the browser window. The form turns purple while it is being completed.
- The form may be manually accessed, saved, and locked by mousing over the Menu tab at the top left side of the form.
- When all forms are complete, check the Completed box at the top of the form on the Internal Documents Screen.
Certification by Principal Investigator

Principal Investigator Certification

This form is to be completed by the Principal Investigator

Project Title: PennEBA Dev

Brief Description (2-3 sentences) of the Research or Proposed Activity - Optional except for ARRA (Stimulus Funding) Proposals

International Component and/or Export Control

*This project has an international component: Yes [ ] No [ ]
*To the best of my knowledge, this is subject to Export Control Laws: Yes [ ] No [ ]

For guidance on making this determination please see the ORS website at http://www.upenn.edu/researchservices/exportcontrols.html

Regulatory and Other Approvals

*All the required regulatory protocol and other approvals have been recorded in the Approvals tab/section of this proposal (these approvals include: human subjects, investigational drugs or devices, laboratory animals, radioactive materials or radiation producing equipment, in vitro formation of recombinant DNA, Select Agents, potentially infectious agents (including human blood or tissues) and carcinogens, teratogens or mutagens).

Certification

Principal Investigator/Project Director

*I certify that no one proposed to work on this project is, to the best of my knowledge, excluded from participation in Federally funded activities as a result of government-wide suspension or debarment. (The complete text of the certification may be found at: http://grants.nih.gov/grants/policy/nihgps_2010/nihgps_qh4.htm#debarment_suspension.)

*This project, if awarded, will be funded either directly or indirectly by the Public Health Service (PHS) or one of its agencies (e.g. NIH).

Research to be funded by the Public Health Service - Financial Conflict of Interest (FCOI) Disclosures and Training Requirements for Investigators:

At the time of proposal submission, all Investigators (senior/key personnel and any other individuals responsible for the design, conduct and reporting of PHS-funded research) must submit a "PHS Financial Interests and Travel Statement" (PHS-FITs) at https://medley.isc.upenn.edu/PhsFits/ppt/start.do#start=investigator. Investigators must also complete FCOI training prior to participating in PHS funded research and then every 4 years in KnowledgeLink.

*I understand that I am responsible for identifying all Investigators (as defined in the paragraph above) on this proposal and advising them of their obligation to complete all FCOI disclosures and training requirements as more fully set forth in the University of Pennsylvania Policy on Conflicts of Interest Related to Research, http://www.upenn.edu/research/pdf/policy_on_conflicts_of_interest_related_to_research.pdf

*In accordance with the Patent and Tangible Research Property Policies and Procedures of the University of Pennsylvania, all personnel on this project, including Postdocs, students and visiting scientists, will have signed Participation Agreements prior to the initiation of this project. (Call the Center for Technology Transfer, 899-9591, for information on inventions, patents, copyrights, etc.)

*I certify that the above information on this form and included in this proposal record is true, accurate and complete as of this date. I understand that any false, fictitious or fraudulent statements or claims may subject me to criminal, civil or administrative penalties. I agree to accept responsibility for the conduct of this project and for provision of required reports if a grant or contract is awarded as a result of this application. If an award is made, I will administer it in accordance with the policies of the sponsor and the University.

Yes [ ] No [ ]
Proposal Transmittal Form

**Proposal Transmittal Form**

<table>
<thead>
<tr>
<th>*Proposal Title</th>
<th>PennFRA Dev</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short Title</td>
<td></td>
</tr>
<tr>
<td>Is this a title change from the previous submission?</td>
<td>Yes ☐ No ☐</td>
</tr>
<tr>
<td>Previous Proposal Number (if known)</td>
<td>Sponsors Proposal/Award ID # (if known)</td>
</tr>
<tr>
<td>Yes PI changed?</td>
<td>Yes ☐ No ☐</td>
</tr>
<tr>
<td>Type of proposal</td>
<td>New Project</td>
</tr>
</tbody>
</table>

**Future Account Segment Information**

| *ORG#| 4+23 |
| *PROG#| 2000 |
| *CREF#| 6789 |

If sub-Accounts will be required, attach and complete a Sub-Account Worksheet.

**Sponsoring Agency/Granting Organization Information**

| Sponsor Contact Name | Sponsor Contact Title | Sponsor Contact Email | Sponsor Contact Address | State | Zipcode |

**F&A Rate (Facilities & Administrative or Indirect Costs)**

| *Are you proposing the federally approved F&A rate or approved clinical trial F&A rate for this activity?| Yes ☐ No ☐ |
| Does the Sponsor have a published policy limiting F&A reimbursement? | (Please note that an email stating an F&A limit is not sufficient.) See University Financial Policy 2116: http://www.finance.upenn.edu/vpfinance/lpm/2100/2100_pdf/2106.pdf |
| ☑ Yes ☐ No |

Please upload the policy on the Internal Documents tab/screen of this proposal.

**Facilities**

| Will this project utilize existing space? | ☑ Yes ☐ No |
| ☑ Yes ☐ No | Will new or renovated space be required for this project? |
| Identify, as specifically as possible, all existing space to be utilized | Please select which will be required | Office space in the Franklin Building |

**Business Administrator Certification**

(or other individual responsible for the proposal preparation and project administration)

| ☑ Yes ☐ No |

The budget and other administrative information on this Transmittal Form and in the attached proposal record are complete and accurate to the best of my knowledge. If an award is made as a result of this proposal, I will administer it in accordance with the policies of the sponsor and the University.
• Once a form is Completed it can be viewed as a PDF by clicking on the PDF icon.
PHS 398 CoverPageSupplement

Overview

Cover page for the proposal which includes information about the project and the University's Organizational information.

- Select PHS 398 Cover Page

Features

- Contains information from previously entered screens.
- Verify information – should be accurate based on Profile page.
- Add any additional information (Degree and County Information are required fields).
- Click [Save] button.
- Check ✔ the Completed box at the top of the form.
Finalize a Proposal for Internal Review

Section Overview

Once you have completed your proposal and all screens are complete, you are ready to begin the Submit process. This process is contained within the menu option called “Finalize”.

Although Proposals can be routed for review and approval if the Research Plan is in “draft” form, all Research Plans should be changed from “Draft Version” to “Final Version” before submission to ORS.

Note: To allow investigators as much time as possible, the research plan of the proposal may be submitted for internal review with Draft Version selected. However, grants.gov requires the research plan of the proposal to be submitted in Final Version. The Office of Research Services is unable to submit a Draft Version to grants.gov. It is the responsibility of the Principal Investigator to submit a Final Version proposal in accordance with Penn’s internal submission deadlines to ensure the proposal is submitted in accordance with the sponsoring agency’s posted submission deadline.
Build Proposal and Assemble Application

Overview

This is the first step in the Submit process. This section builds a PDF document from all completed sections. Should any section be changed after this build, then the proposal will have to be re-built.

Features

- Click **Finalize** on the **Sidebar Menu**.
- Click **[Build]** to convert your proposal into a PDF format.

- While it is building the proposal, you will see status for each form update from Building to Built in the Last Built column.
- When finished, the build date and PI are displayed in the Last Built and Built By columns.
- You may view a PDF of each form.
• Click [Build Grants.gov Application] to create the application package.

• Generic forms require you to place your forms in order.
• Wait while your application builds.
Submit for Internal Review

Overview

From this page the proposal is finalized prior to internal routing and approval. If the PI Certification and Proposal Transmittal forms were not completed on the Internal Documents tab, they should be completed here. The Certification by the PI and Proposal Transmittal Form must be completed before the proposal can be submitted for internal approval. For detailed instructions refer to Internal Documents on the Sidebar Menu.

Features

- Completion of documents for the final routing through University approvals paths to ORS to the funding authority.
- Click the “Edit” icon to complete the Certification by PI form if not already complete. (see Internal Documents section)
- Click the “Edit” icon to complete the Proposal Transmittal form if not already complete (see Internal Documents section)
- Select the eyeglass of PDF icons under “Current Submission” to view a PDF version of the forms.
- Click the link labeled Add Institution Forms/Supporting Documents to attach documents that will not be sent to the sponsor, but are required by the University.
- If you have other forms that you want to go to the Sponsor, use “Other Attachments.”
- When all forms have been Completed click the icon.
  - The PI or another authorized person, usually the BA, can complete this step.
  - Click [Submit]
  - Approval routing path pop-up box appears, Add New Person to Review Path or click [Submit] to send proposal to reviewer/approver.
Submit for Routing and Approval

Overview

This screen allows the PI or other designated person to route the proposal for internal approval.

Features

• Click on the [Submit Final Review] icon to begin the routing process.
• A certification will be displayed.

Certification

[Image of a certification form with options: Accepted, Declined, and Continue]

Read, select ‘Accepted’, if appropriate, and click [Continue].

• Click the link [Add New Person to Review Path] to add Approvers or Reviewers or click [Submit].

• Select the insert icon next to an individual in the routing path to insert an Approver or Reviewer after that particular step.

• People added to a route can be an Approver or a Reviewer. To make someone a Reviewer, select the radio button, “Information only” when adding them to a route. To make someone an Approver, select the radio button, “Approval Required” when adding them to a route.

• Begin typing the name and select the correct option from the list.
• Click [Add].
• Click [Submit] to send the proposal into the approval queue.
Status of Approval Process

Overview

Once the proposal has been submitted for internal routing, the user may return to the **Finalize** screen to determine the progress of the proposal through the routing path.

- Each person on the approval route will receive an email and a PennERA message to alert them to your proposal.
- Click the **Open** icon to review the “notification” and “decision” status for each person on the approval route.
- Click **[Done]** when completed and to exit the proposal process.
Review, Approve or Reject a Proposal

Section Overview

When someone is defined as an Approver for a particular proposal, he/she must either approve or not approve the proposal. Upon approval, the proposal routes to the next defined step in the path. Upon rejection, an email and PennERA message is sent to the PI who originally sent the proposal.

- Reviewers receive a copy of the Proposal for informational purposes only.
- Approvers receive a copy of the Proposal and act upon the Proposal to either approve or reject the Proposal. The Proposal cannot progress to the next step in the routing process unless the approver acts upon the Proposal.
- The Approver can insert additional people into the routing path.
- Approvers can also see who has already seen/approved the Proposal and who is next in the routing path.
- Approvers can add comments as part of the review process. Comments can be shared (optionally) with only the Investigator, only Administrators, only approvers, or everyone.
Message Received by Approver/Reviewer

Overview

When a proposal is routed for approval or review, the recipient receives both an external (University) email and internal (within PennERA) message.

Features

1. A Reviewer will receive a link to a copy of the proposal.
2. An Approver receives a link that will direct him/her to the Review Dashboard.

External Email – For Approver

External Email – For Reviewer

The Review Dashboard may also be accessed through My Action Items in the portal browser window.

- Click on to open the Review Dashboard in the list of ‘My Open Action Items’.
- Previously reviewed and completed items may be viewed by clicking on ‘Completed’ under ‘My Action Items’.
The reviewer/approver may also access the Review Dashboard through the internal PennERA notification system at **My Messages**.

- Click on **Inbox** to access a list of messages.
- Click on the envelope icon to view the message.
- Access the Review Dashboard or the Proposal from the message.

### Internal Email – for Approver

![Internal Email for Approver Image]

- Open Reviewer Dashboard to enter decision (if an approver)
- Open Proposal (security rules determine who can access)

### Internal Email – for Reviewer

![Internal Email for Reviewer Image]

- Open Proposal to Review.
Reviewer Dashboard - Help Screen

Overview

This screen allows an approver to access the dashboard. Information about the Review Dashboard, instructions for completing the review, and contact information are displayed on this tab.

You have been identified as someone who needs to perform an on-line review.

The “Review” tab allows you to:

- View comments by previous reviewers.
- Add your comments for others to view.
- Indicate which items you have reviewed.
- Record your review decision.

The “Routing” tab:

- Displays the review progress to date and the remaining steps in the approval process.
- Allows you to insert additional approvers or information-only reviewers.

Many of the items being reviewed have deadlines, so please act accordingly. In order to access this information, you will need unsure of your username/password, please click here.

On the “Review” tab:

1. View each item that is applicable to your review. After viewing, mark “Reviewed”. Mark unreviewed items as “Not Applic.
2. You may choose to add comments.
3. Indicate your decision in the “My Decision” section. This is the ultimate and final action required of you.
4. Click the Save icon in the upper right corner.

If you intend to add comments, you should do so before you set your decision.

If you have any questions regarding this process, please contact:

CHRISTIAN BITTO
FRANKLIN BUILDING
P221 FRANKLIN BLDG
215-986-7283
PHILADELPHIA, PA 19104-6205
Phone: 2158967293

- Click on [Review].
Reviewer Dashboard - Review Screen

This screen allows an approver to approve or reject a proposal, add comments, and track the proposal.

Features

- You may access the following from this screen: the actual proposal in PD, PDF (Assembled Doc) of the proposal, the Certification by PI and the Proposal Transmittal Form.
- After you review each item, use the dropdowns to record your review decision as Reviewed or Not Applicable.
- Add Comments where appropriate. You may not add comments after you enter your decision to approve or not approve the proposal.
- Once you have marked everything “Reviewed” or “Not Applicable”, click on the Save icon.
• You now have the ability to either approve or disapprove the proposal.
• Select Approved or Not Approved from the dropdown.
• Click on the Save icon.

![Proposal Approval Screen](image)

• The pop-up reminds you that once you click [OK] you will lock all fields in the Review Form and not be able to add comments or make changes.

![Pop-up Reminder](image)

• Click [OK].

**Note:** Changes can be made by anyone who has access/edit privileges to a proposal during all stages of the proposal creation process. Changes to the proposal in the approval process require the proposal to be “Built” again.

You may make changes to the Proposal Routing by clicking on [Route]. Go back to Submit for Routing and Approval for detailed instructions.
Submit to Sponsor

Section Overview

Once ORS submits the Proposal to the Sponsor, the Sponsor may accept the Proposal or return it for modification, or reject it completely.

ORS submits the Proposal either electronically (for those Sponsors who support electronic submission) or, if the Proposal is to be submitted via hard copy, the PI prints the Proposal and submits it to the Sponsor. In this case, ORS will print the “signature page”, sign it and return it to the PI (usually via the administrative contact).

ORS is the conduit for submission to the Sponsor and usually for Proposals returned by the Sponsor for modification. Questions or concerns about a returned Proposal should be handled through ORS.

Electronic Submission to Sponsor (i.e., Grants.Gov)

Overview

Check the “Finalize” screen to determine the Grants.Gov ID#, status, etc.

Features

• If the Sponsor detects a problem with the Proposal, it is returned via ORS for edit/correction.
Submit Other/Paper

Overview

Click the icon to view and print a PDF document if needed for paper records or submission to the Sponsor.

Features

- A user can print a copy of their proposal by accessing the proposal through Proposal Development, and selecting “Finalize” from the Sidebar Menu. Then, select the icon under the heading “Completed Form” to view a PDF version of the proposal. At this point, the user may print out the PDF document or save it to his/her computer.
Appendix A

How do I... directly add personnel to the Personnel Tab if I want to do it that way?

Note: While you may use this process for adding personnel, the preferred method is to add personnel on the Budget Items Tab.

Add Personnel
The first step for adding all personnel types is to click Add.

Add Existing Personnel to the Penn Budget

1. Select Personnel Type in the pop-up window.

2. Locate an Existing Staff name in the alpha-split list.
   - Notify PennERAhelp@lists.upenn.edu if a name cannot be located.
   - Effort can be entered for Key and Non-Key Personnel at this step or added later.

2. Click Select to complete the addition process.
   - If Key or Non-Key Personnel Type was selected in Step 1 above, the screen will refresh to Budget Detail view.
     - Budget detail may be added now, or you can return to the Personnel tab without saving or making any changes in the Budget Detail screen.
ii. See steps for entering budget detail in the Budget section following.
   • If Other Significant Contributor or Consultant Personnel Type was selected in Step 2, the screen will refresh to Personnel.

3. Continue to add personnel by clicking **Add**.

**Add New Personnel**

Follow these instructions to add the following personnel:

- New staff to be hired by Penn if project is funded, named or to be determined (TBD).
- Other Significant Contributors who are external to Penn.

Subcontract personnel are added through the subcontract expense component of Budget Items.

1. Select Personnel Type in the pop-up window.

2. Add information in the Add New Staff section.
   - Minimum information required
     First/Personnel Title
     Last
     Department
     Institution
   - Effort may be entered now or later for Key and Non-Key Personnel.
3. Click [Add as Key Personnel] or [Add as Non-Key Personnel] to complete the addition process.
   • **IMPORTANT REMINDER:** “TBD’s” may only be used for Non-Key Personnel Type. All other selected Personnel Types must have known individuals entered in this section, even if they are currently not employed by Penn but will be if the project is funded.
   • The screen will refresh to Budget Detail view.
     i. You can navigate back to the Personnel tab without making any changes or saving, or budget detail can be added at this point.
     ii. See steps for entering budget detail in the Budget section following.

4. Continue to add personnel from the Personnel screen by clicking [Add].
Add External Consultants

Follow these instructions to add the Key and Non-Key External Consultants.

1. Select Personnel Type: External Consultant - Key or External Consultant - Non-Key.
2. Let the screen refresh.

3. Select External Institution, then select from existing names for that institution.
   - If the external institution or the person's name is not available for selection, follow the instructions in Step 4 below for using the Add New Staff section.
4. When an External Institution is not listed or if the person to be added is not already included in that institution's list of available personnel, use the Add New Staff section:
   • Minimum information required
     First/Personnel Title
     Last
     Department
     Institution

   ![Add New Staff Form]

5. Click Add as Key Personnel or Add as Non-Key Personnel to complete the addition process.
   • The screen will refresh to Budget Detail view.

6. Choose Consultant for Role on Project and Save this screen

   ![Project Responsibilities]

7. Continue to add personnel from the Personnel screen by clicking Add.
How do I... change the PI?

The default PI on a proposal is the person who originally creates the proposal. This information can be changed in several locations.

A. New Proposal Questionnaire
   - Select My Proposals > Create New Proposal
   - Click the Change link next to the PI’s name

![New Proposal Questionnaire](image)

- Begin typing the PI/s name in the box and select the PI from the list (make sure ORG information is correct).

![Personnel Listing](image)

- Click [Select].
  - Complete the proposal creation process.
  - Associated Department will be that of the new PI.
  - Approval routing will be based on the new PI’s approval routing path.
B. Budget > Budget Periods and Setups

- On the “Change PI” line click on the Change link.

- From the dropdown box select Replace PI and Leave the Current PI on the Proposal or Replace and Remove the Current PI.

- Choose the new PI from the alpha-split list and click [Select].

---

*Note:* Budget information for the new PI will have to be added to the proposal. If the original PI was not removed in the above step, s/he can be removed later.

Other forms that may need to be changed, if the PI is changed, are:

- Personnel – upload new CV/biosketch
- Performance Sites
- Resources, especially Facilities
- Budget > Budget Items – effort, salary; other budget tabs as necessary
- PHS 398 Cover – degrees
C. SF424 (R&R)

- Uncheck the “Completed” box at the top of the page.
- Click on the Change link in Section 14.

A new window opens. Scroll to the top.
- From the dropdown box select Replace PI and Leave the Current PI on the Proposal or Replace and Remove the Current PI. Choose the new PI from the alphabet list and click [Select].
- Check the Completed box at the top of the form.
How do I... add or change default Associated Department?

Department and Center information defaults to the PI’s information, but often multiple Departments or Centers will work together on a proposal.

- On the “Setup Questions” page in the “General Proposal Properties” section of the questionnaire, click the Add link in the Associated Departments row.

- Begin typing the department name and select the department from the list.
  - Click [Select].
  - Click [Save].

- Click the appropriate radio button beside the Primary Department.
  - Primary (“Prime”) department = routing path for approval of proposal.

  Note: At Penn, this is also known as the “Responsible Org”.

- Add any Departments for which a subaccount will be issued if the project is funded.
- Remove any Departments that will not have a subaccount issued if the project is funded.
  - Informational copies of the Proposal can be provided during routing and approval for participation departments for which a subaccount will not be issued.
How do I... create a simplified budget?

A simplified budget may be created for any generic record and for modular budgets in an S2S record.

**NOTE:** The example is for an S2S modular budget, but the same type of budget entry is applicable to any generic record.

**Budget**
- Click on **Budget > Budget Items**.

  ![Budget Items](image)

  - Add all Key Personnel included with the proposal.
    - Click on the **Budget** link next to the PI already associated with this proposal.
    - Add the Effort for the PI.

  ![Personnel Costs](image)

  - Click [Save].
  - Next click on [Add] to add additional Personnel.
1. Find the individuals you wish to add on the alpha-split list. You may also add the Effort or you may do that on the next screen.
2. Select Key or Non-Key from the dropdown.
3. Click [Select].
4. The screen refreshes and takes you back to **Budget Items** which includes the added Personnel.
5. Click on the **Budget** link.
6. Define role on the project and update Key Personnel effort.

- **Click on [Save]** select **Budget Items** from the **Sidebar Menu**.
• Enter your total direct expenses by adding one non-personnel expense line.

• Select the **Budget** link from the Non-Personnel Costs section.
• Enter a description of the direct expense
• Select Budget/Charge category “Other Costs”.
• Enter the expense amount for each year.
• Click **Save** to perform calculation.

• Click **Budget Items**.
• Check the **Completed** box for Budget Items.
F&A

- Select the F&A form from the **Sidebar Menu**.
- If the Sponsor provided F&A
  - Enter the amounts per period.
  - Click on [**Save**].
  - Check the **Completed** box at the top of the form.
- If the Sponsor did not provide F&A, check the “Completed” box (assuming you agree with the system calculation).
Cost Sharing

- Click the Cost Sharing form on the Sidebar Menu.
- Check the Completed box at the top of the form (assuming you agree with the system calculation).
**Modular Budget**

- Click **Modular Budget** tab on **Sidebar Menu**.
- Select the number of modules you are requesting for each budget period from the dropdown located in the middle of each “block” and click **[Save]**.
  - **Note:** It’s imperative you click **Save** before you complete the modular budget page.

- **Justifications**
  - Select **Justifications** tab on **Sidebar Menu**.
  - Upload your budget justification including Subcontractor Justification if applicable.
    - Click on **[Browse...]**.
    - Select a Word or PDF.
    - Click on the **Upload** link.
  - Check **✓** the “**Completed**” box once all Justifications are uploaded.
How do I... budget for F&A exemption expenses like equipment in a simplified budget?

**Solution:** While you could create a budget containing only one line for total direct costs and adjust the F&A manually, we recommend you create separate line items for these types of expenses. The application will NOT calculate F&A on budget categories exempted from F&A, such as Purchased Equipment. If you use the correct categories in your budget, you won’t have to remember to adjust the F&A manually.

Example: This proposal includes expenses totaling $125,000 and $150,000 in years 1 and 2, respectively. In this example, $15,000 is budgeted for equipment in the first year only. Your budget would look like this:

![Budget Items](image)

Once you complete this section, go to the F&A page. Note the F&A base reflects the total less the equipment exemption.
If you are using a modular budget, below is the example for the equipment expense.

![Modular Budget Table]

- Always click [Save] before you complete the Modular Budget page.
- Check the Completed box at the top of the form.
How do I... enter genomic array (microarray) expense?

Genomic array (GA) expense incurred with an external vendor requires specialized data entry as outlined in NIH Notice NOT-OD-10-097, issued May 2010 (http://grants.nih.gov/grants/guide/notice-files/NOT-OD-10-097.html). This is a requirement for NIH proposals only, modular budget proposals and those requiring the 424 detail budget forms.

*Note:* Microarrays obtained from internal resources/service centers should continue to be treated as supply expense with full F&A recovery.

If the annual cost does not exceed $50,000/year for each external source, these special steps are not required. The expense should be budgeted as supply costs.

If the expense exceeds $50,000 in any year, then follow the steps outlined below. Use for any record type (S2S or generic template), and all budget entry methods: modular, simplified, detail.

Only the cost of the arrays should be included: No staff time or other associated sequencing costs should be included in this calculation methodology.

**Setup Questions tab**

- General Proposal Properties -- Answer “yes” to subcontractor question.

**Budget tabs**

**Budget Items tab:**

- Create a new expense line in the Non-Personnel Expense section.
  - Description – “Genomic Arrays to annual limit ($50,000)"
  - Budget Category – “Other Costs”
  - Enter annual GA costs, not to exceed a maximum of $50,000/year.

- Create a new subcontractor entry.
  - Choose “GENOMIC ARRAYS - EXTERNAL” as the subcontractor name.
  - Choose “Arrays, Genomic” as the PI.
  - Enter subcontract PI expense line and make the following adjustments:
    - Role of Project = Other (Describe), enter “Genomic Arrays”
    - Effort = 0.10 in any year that has expense
  - Create a Non-Personnel Expense entry.
    - Description – “Excess of GA expense over $50,000”
    - Budget Category – “Other Costs”
    - Enter amount that exceeds $50,000 in any year.
    - DO NOT ENTER ANY VALUES IN THE F&A LINE.
    - If any year = $0, mark the year “Inactive”.

**F&A tab:**

- Choose Sponsor Calculation Method – Manual (line by line).
- Edit the GENOMIC ARRAYS subcontract information:
  - Sponsors F&A Base’ *IN EVERY YEAR* should = ‘Sponsors Directs’ expense line or $25,000, whichever is the lesser amount.
  - Calculate and enter ‘Requested F&A’ based on ‘Sponsors F&A Base’.
Cost Sharing tab:

• Move any costs on ‘Indirect Costs’ line from ‘Inst’ to ‘UnAllow’.

Modular Budget tab:

• Save the tab after the screen has opened even though there has been no editing yet.
• Adjust the number of modules in each year, if necessary; Save.
• Check modular budget calculation chart to ensure that all values are correct.

Justifications tab:

• Prepare the type of justification required for the proposal.
• Include this explanation of the subcontract for the GA expense:

  Budget Justification for Genomic Arrays

  In accordance with NIH Notice OD-10-097 (Budgeting for Genomic Arrays for NIH Grants, Cooperative Agreements and Contracts), a subcontract has been created for the Genomic Array expense that exceeds $50,000 in any given budget period of this proposed project. This is an S2S submission which requires listing a PI for this ‘subcontract’ with a small amount of (unfunded) effort to avoid validation errors.

  Genomic array expense up to $50,000/year has been included in the University’s portion of the project budget under the cost category Supplies.

  Questions regarding this methodology should be directed to the Signatory Official.

• If this is a modular budget justification, upload to the “Consortium Justification” location.
• If a 424 detail budget justification is prepared, include this paragraph with the Penn justification.

[Screen shots of the budget entry appear on the next two pages.]

Personnel tab:

• Upload a “biosketch” for the “PI” of the GA subcontract.
• Do not use a formatted biosketch or NIH biosketch form; create a standard Word document with the following text:

  This is a biosketch upload for the “PI” location of the subcontract created in a system-to-system proposal record to accommodate the necessary calculations for genomic arrays per Notice NOT-OD-10-097 (Budgeting for Genomic Arrays for NIH Grants, Cooperative Agreements, and Contracts), requiring treatment of a certain portion of the genomic array expense as a subcontract.

Performance Sites tab:

• Make the following entries for the GA “site”:
  o Enter zeroes for the DUNS number (00-000-0000).
  o Enter PA-002 for the Congressional District.
  o Enter external vendor’s information for the address.
**Penn F&A tab**

**GENOMIC ARRAYS – EXTERNAL (NATIONAL INSTITUTES OF HEALTH)**

**F&A tab**

### Facilities and Administration Costs

<table>
<thead>
<tr>
<th>Sponsor Calculation Method</th>
<th>Institution Basis/Target Scheme Show</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manual (line by line)</td>
<td>$75,000 Research On-Campus Scheme</td>
</tr>
</tbody>
</table>

#### PERSONNEL COSTS

<table>
<thead>
<tr>
<th>Period</th>
<th>Period 2</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### NON-PERSONNEL COSTS

<table>
<thead>
<tr>
<th>Period</th>
<th>Period 2</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### SUBCONTRACTORS

<table>
<thead>
<tr>
<th>Period</th>
<th>Period 2</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Penn Cost Sharing tab**

**GENOMIC ARRAYS – EXTERNAL (NATIONAL INSTITUTES OF HEALTH)**

**Cost Sharing tab**

### INDIRECT COSTS

<table>
<thead>
<tr>
<th>Line Total</th>
<th>Period 2</th>
<th>Period 1</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Grand Total**: $350,000.00
How do I... resize scanned documents or odd-sized PDFs?

Grants.gov and other electronic submission systems required uploaded documents to be 8½ x 11 inches. Most scanned documents will not be exactly that measurement, so they will need to be resized before they can be uploaded into Proposal Development.

If an uploaded document is not the correct size, an error message will appear when an upload is attempted.

**Note:** Adobe Acrobat Professional is required to resize PDF documents.

- **Determine the page size**
  - Open the scanned document in Acrobat Pro.
  - Select **Properties** from the File menu.
  - Check the **Page Size**.

  **Note:** PDF documents created by combining scanned and converted pages will have some pages that are correctly sized. Any page may be checked by first going to that page, then checking page size.
• Change the Page Size
  - Open the Print dialog box from the File menu.
  - Choose Adobe PDF as the printer.
  - Remove the checkmarks, if present, from Print to file and Choose Paper Source. The document measurements should change to 8.5 x 11.
  - Click [OK] to print.

• Check the new PDF
  - Close the original document and open the new one.
  - Check Properties to verify the Page Size.
How do I... change project/budget period dates or add or remove budget periods?

It may be necessary for the project period start and/or end dates to be shifted when an existing proposal is copied, if a typographical error is made when entering the project period dates in the proposal creation questions, or if the PI changes the anticipated start date after the proposal has been created. For similar reasons, the number of Budget Periods may also need to be increased or decreased.

- From Sidebar Menu, select [Budget], then select [Budget Periods and Setups].

Shifting the start and end dates of the project

**NOTE**: Use the “Project Period” section only to change (shift) the start and end dates of the project if the number of budget periods is already correct. Do not use the “Budget Period” section to change the dates unless instructed by end-user support staff to edit dates there.

Determine the best option to modify the dates:

**Note**: If you need to add or remove Budget Periods, complete that step first. See the next section for instructions on that process.

1. **“Shift by”**
   - This is the best and most reliable option to use, especially if some budget data has already been entered.
   - Both the start and end dates are shifted forward or backward by the number of days, weeks, or months designated by the user.

2. **“Project Start” and “Project End”**
   - Use this option when the start and end dates need to be changed by different amounts.
   - The user enters the new dates. The start and end dates of each period will be adjusted according to the new information.
Option 1: “Shift by”

- Click the [Shift] button (previous page) to display **Shift Project Dates**.
- Enter the amount then choose days, weeks, or months from the dropdown.
- To move the dates backward, enter negative values, e.g. “-1” month.
- Click [Save].
- **WAIT** while the new project period is calculated and **Shift Project Dates** screen is closed.
- **WAIT** while **Budget Periods and Setups** page is refreshed and new dates are displayed.

```
<table>
<thead>
<tr>
<th>PROJECT PERIOD</th>
<th>Start</th>
<th>End</th>
</tr>
</thead>
<tbody>
<tr>
<td>01-Aug-2015</td>
<td>31-Jul-2017</td>
<td></td>
</tr>
</tbody>
</table>
```

- Start and End Dates for Project Period have been reset.
- Dates for each budget period have been reset.

Option 2: Specify new “Project Start” and “Project End”

- Starting with the last date working backwards, delete each date entry and enter the new start and end dates.
- Both a start and an end date must be entered, even if one of those dates is not changing.
- Click [Save].
- **WAIT** while the new project period is calculated and **Shift Project Dates** screen is closed.
- **WAIT** while **Budget Periods and Setups** is refreshed and new dates are displayed.

```
<table>
<thead>
<tr>
<th>BUDGET PERIOD</th>
<th>Start</th>
<th>End</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>01-Aug-2015</td>
<td>31-Jul-2016</td>
</tr>
<tr>
<td>2</td>
<td>31-Jul-2017</td>
<td>31-Jul-2017</td>
</tr>
</tbody>
</table>
```

- Start and End dates for Project Period have been reset.
- Budget periods have been reset.
- Dates for each budget period have been reset.
Adding or deleting Budget Periods

NOTE: Use the “Budget Period” section only to change the number of Budget Periods in the project (add or remove). Do not use the “Budget Period” section to change the dates unless instructed by staff to edit dates there.

- In the “Budget Period” section, click [Add] or [Remove].
- Click [OK] to continue.
- WAIT while Budget Periods and Setups is refreshed and the changed number of periods is displayed.
How do I… view the cumulative budget totals?

- Choose **Budget > Budget Periods and Setups**
  - Check **Show Budget Summary** radio button.
  - Click on **[Save]**.
- Choose **Budget > Budget Items** on the **Sidebar Menu**.
  - Choose any budget line item: This example uses one of the personnel entries.
  - Click on the **Budget** link to open the detail screen for that item.
- Scroll down to the **Budget Summary Section**, click in each of the checkboxes to view the accumulating costs for this proposal.
  - **Project** – Total project costs.
  - **NATIONAL I…** – The second group of costs is always the sponsor’s total costs.
  - **8670-Res…** – The third group of costs is institutional, formal cost-sharing. This cost-sharing will be included on the SF424(R&R) face page.
  - **8670-Res…** – The final group of costs is unallowable expense. Usually the only expense in this category is the amount of salary (and associated fringe benefits) for personnel whose annual salary exceeds the NIH cap. This is not formal cost-sharing, but is expense not supported by the sponsor. It will not be included on the SF424(R&R) face page.

See Screenshot of expanded Budget Summary Section on the following page.
Note: Because the values are constantly updated as the budget is developed, the expanded sections are not automatically open on each budget detail screen view. Just re-check the boxes to view the budget details.
How do I... budget for Academic and/ or Summer appointments?

Providing the necessary data in PennERA Proposal Development for faculty with academic/ summer appointments is only required when a 424 R&R detail budget must be submitted to Grants.Gov. In all other instances, it is not mandatory to provide this information in PD unless the School or Department wishes to have this information entered.

Simple entry of summer/ academic appointment information

When a spreadsheet with the budget detail has already been developed, a simplified method of data entry can be used to provide the information in PD for the 424 R&R detail budget information.

424 detail forms only require person months for academic and summer or calendar appointees. Salary and benefit information does not need to be provided by these classifications.

1. **Setup Questions**
   - Choose either “Budget Period by Period” or “Budget by Total Project” budgeting model.

2. **Create personnel detail based on 12-month (annualized) salary.**
   - Determine annualized salary: Monthly salary x 12 months.
   - Be sure to consider any salary changes that may occur during the first budget period.
   - Determine annualized effort: Totals months’ effort for first year / 12 months = annualized percent of effort.
   - Click on [Save].
   - See example below:

3. **Adjust (Manual Override) for automatic calculation.**
   - Check “Allow Manual Override of Person Months”.
   - Let the screen refresh: The Person Months are now editable in each of the three columns – ACAD, CAL, and SUMR.
   - Enter the planned months in the appropriate columns.
   - CAL months cannot be combined with any other column.
   - Can combine ACAD and SUMR months or have months in only one of these two columns.
See results below for above example:

<table>
<thead>
<tr>
<th>Period</th>
<th>Effort</th>
<th>ACAD</th>
<th>CAL</th>
<th>SUMR</th>
<th>Amount</th>
<th>Inc.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jul-15 to Jun-16</td>
<td>10.00%</td>
<td>0.00</td>
<td>0.00</td>
<td>1.20</td>
<td>$13,200</td>
<td></td>
</tr>
<tr>
<td>Jul-16 to Jun-17</td>
<td>15.00%</td>
<td>0.00</td>
<td>1.80</td>
<td>0.00</td>
<td>15,800</td>
<td></td>
</tr>
<tr>
<td>Jul-15 to Jun-17</td>
<td>12.50%</td>
<td>0.00</td>
<td>1.60</td>
<td>1.20</td>
<td>$33,000</td>
<td></td>
</tr>
</tbody>
</table>
Using PD to develop the academic/summer appointment expense

When PennERA is used to create the budget without a pre-existing spreadsheet, use the steps below to calculate expense for academic/summer appointees.

1. Setup Questions
   - Choose “Budget by Total Project” budgeting model.

2. Budget Items
   - Click on Budget > Budget Items
   - Click the Budget link to open the personnel folder and access the salary/effort screen for existing personnel or choose [Add Appointment].

Creates two appointments for this one person.
3. **Define the Appointment parameters:**

- **For the Academic appointment, perform the following steps:**
  - Select the Appointment Type “ACAD” from the dropdown menu.
  - Type in number of months.
  - Enter a start date of 09/01/15 (start of the academic year in which the appointment begins).
  - Enter an end date of 05/31/16 (end of the academic year in which the appointment begins if this is a 9 month academic year).
  - Enter salary and benefits information. In this example, the salary for 9 months is $100,000.
  - Select Radio Button – **[Recycle Salary on the Annual Anniversary]** to reflect this salary information in each period of the proposal beginning 09/01.

- **For the Summer appointment, perform the following steps.**
  - Select the Appointment Type “SUMR” from the drop-down menu.
  - Type in number of months.
  - Enter a start date of 06/01/15 (start of the summer in which the appointment begins, not necessarily the date of the appointment).
  - Enter an end date of 08/31/15 (end of the summer in which the appointment begins)
  - Enter salary and benefits information. In this example, the summer salary is $33,333.
  - Select Radio Button – **“Recycle Salary on the Annual Anniversary”** to reflect this salary information in each period of the proposal beginning 09/01.

- Select Annual Inflation – “Cost of Living (3%)”.

---

**Budget Detail for: MS LAUREN G OSHANA**

**Salary/Payroll Information**

- **Type:** ACAD
- **Appointment Start/End:** 01-Sep-15 to 31-May-16
- **Base Salary:** $100,000.00
- **Fringe Benefits:** Full Time Federal
- **Net Salary:** $60,000.00

**Budget Detail for: STEPHEN FRATANTARO**

**Salary/Payroll Information**

- **Type:** SUMR
- **Appointment Start/End:** 31-Jun-15 to 31-Aug-15
- **Base Salary:** $33,333
- **Fringe Benefits:** Full-Time Federal
- **Net Salary:** $20,000.00
4. Define the Effort parameters - Time and Effort section - enter the individual period.

- Define effort for the PI’s appointments (for example: 25% effort in Academic year, 75% effort during Summer session) as follows:
  - Since the project is scheduled to begin on 01/01/16, the first period you define will be 01/01/16 – 05/31/16 (start of the project to the end of the academic year). Enter 25% effort for this period.
  - The next period will be the summer appointment, so enter 06/01/16 - 08/31/16. Enter 75% for this period.
  - Click [Save] to add more Effort lines and calculate the data entered so far.
  - Next, you'll enter a period covering the entire academic appointment. Enter 09/01/16 – 05/31/17. Enter 25% effort.
  - Now, enter the summer appointment, so enter 06/01/17 – 08/31/17. Enter 75% effort.
  - The final period to enter is 09/01/17 – 12/31/17. Enter 25% effort.
  - Click the [Save] button.

**Note:** If the effort is the same for both the Academic and Summer appointments, it is not necessary to repeatedly enter each year.

Some sponsors do not require separate budget calculations for investigators who hold Academic/Summer appointments (e.g., NIH). If the effort is the same throughout the budget period (or for all periods) and if the monthly salary does not change, except on the basis of annual inflation, then it is not necessary to complete an ACAD/SUMR appointment salary structure unless required by your department.
How do I... create Non-Personnel expenses for “Budget by Total Project”? 

- Select **Budget Items** from the **Sidebar Menu**.
- Select **Non-Personnel Expenses**.
- Click the **Add** link.

**PERSONNEL COSTS**

<table>
<thead>
<tr>
<th>Name / Role</th>
<th>Type</th>
<th>Effort</th>
<th>Period 1</th>
<th>Period 2</th>
<th>Period 3</th>
<th>Period 4</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Budget</td>
<td>Key</td>
<td>0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
<tr>
<td>Total</td>
<td></td>
<td></td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
</tbody>
</table>

**NON-PERSONNEL COSTS**

<table>
<thead>
<tr>
<th>Budget Cat.</th>
<th>Item</th>
<th>Period 1</th>
<th>Period 2</th>
<th>Period 3</th>
<th>Period 4</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Budget</td>
<td>Administration – Enter Item Name Here –</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
<tr>
<td>Budget</td>
<td>Other Costs – Genomic Arrays to annual limit ($50,000)</td>
<td>$50,000</td>
<td>$50,000</td>
<td>$50,000</td>
<td>$50,000</td>
<td>$250,000</td>
</tr>
<tr>
<td>Total</td>
<td></td>
<td>$50,000</td>
<td>$50,000</td>
<td>$50,000</td>
<td>$50,000</td>
<td>$150,000</td>
</tr>
</tbody>
</table>

- Enter the Description of the expense – “Lab supplies”.
- Select the **Budget/Charge Category** – “Supplies”.
- Select **Annual Inflation** rate – “Cost of Living (3%)”.

**BUDGET JUSTIFICATION**

Please enter your justification below

**PURCHASE/USAGE SCHEDULE**

<table>
<thead>
<tr>
<th>Units/Qty</th>
<th>Price/Charge Each</th>
<th>Total</th>
<th>Charge Start Date</th>
<th>Charge End Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>60,000.00</td>
<td>60,000.00</td>
<td>01-Apr-2013</td>
<td>31-Mar-2017</td>
</tr>
</tbody>
</table>

**COSTS BY “BUDGET PERIOD”**

<table>
<thead>
<tr>
<th>Period</th>
<th>Start Date</th>
<th>End Date</th>
<th>Cost to Project</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>01-Apr-2013</td>
<td>31-Mar-2014</td>
<td>$12,500.00</td>
</tr>
<tr>
<td>2</td>
<td>01-Apr-2014</td>
<td>31-Mar-2015</td>
<td>$12,875.00</td>
</tr>
<tr>
<td>3</td>
<td>01-Apr-2015</td>
<td>31-Mar-2016</td>
<td>$13,281.25</td>
</tr>
<tr>
<td>4</td>
<td>01-Apr-2016</td>
<td>31-Mar-2017</td>
<td>$13,658.09</td>
</tr>
<tr>
<td>ALL</td>
<td>01-Apr-2013</td>
<td>31-Mar-2017</td>
<td>$52,995.34</td>
</tr>
</tbody>
</table>

**Note**: there initially is only one line to enter the expense item. If necessary, additional blank lines will be added after each Save.
• **Example 1:**
  Total costs to the project are $20,000 (current value), or 1 unit \( @ \) $20,000 spread evenly over all budget periods.
  - **Units/Qty** – How many are you buying? Enter “1”.
  - **Price/Charge** per units or total quantity information. Enter “$20,000”.
  - Change **Charge Start Date** and **Charge End Date** to define the periods in which the cost will be incurred. Since the costs will be spread over all budget periods, in this example, you only need to change the end date to 03/31/17.
  - Click [Save] to calculate the Costs by “Budget Period” section.

This example could also have been entered as 2 units (years) \( @ \) $10,000 annual costs.

**PURCHASE/USAGE SCHEDULE**

<table>
<thead>
<tr>
<th>Units/Qty</th>
<th>Price/Charge Each</th>
<th>Total</th>
<th>Charge Start Date</th>
<th>Charge End Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>$20,000.00</td>
<td>$20,000.00</td>
<td>01-Apr-2016</td>
<td>31-Mar-2018</td>
</tr>
</tbody>
</table>

**COSTS BY “BUDGET PERIOD”**

<table>
<thead>
<tr>
<th>Period</th>
<th>Start Date</th>
<th>End Date</th>
<th>Cost to Project</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>01-Apr-2016</td>
<td>31-Mar-2017</td>
<td>$10,000.00</td>
</tr>
<tr>
<td>2</td>
<td>01-Apr-2017</td>
<td>31-Mar-2018</td>
<td>$10,000.00</td>
</tr>
<tr>
<td>ALL</td>
<td>01-Apr-2016</td>
<td>31-Mar-2018</td>
<td>$20,000.00</td>
</tr>
</tbody>
</table>

• **Example 2:**
  Costs to the project are $10,000 in the first budget period, but only $5,000 in the second.
  - **Units/Qty** – Enter “1” for each budget period.
  - **Price/Charge** – Enter “$10,000” and “$5,000” in the appropriate periods.
  - Change **Start Date** and **Charge End Date** – Change the end date for the first item to 03/31/15 (first budget period); dates for the second item are 04/01/15 and 03/31/17.
  - Click [Save] to calculate the Costs by “Budget Period” section.

**PURCHASE/USAGE SCHEDULE**

<table>
<thead>
<tr>
<th>Units/Qty</th>
<th>Price/Charge Each</th>
<th>Total</th>
<th>Charge Start Date</th>
<th>Charge End Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>$10,000.00</td>
<td>$10,000.00</td>
<td>01-Apr-2016</td>
<td>31-Mar-2017</td>
</tr>
<tr>
<td>1</td>
<td>$5,000.00</td>
<td>$5,000.00</td>
<td>01-Apr-2017</td>
<td>31-Mar-2017</td>
</tr>
</tbody>
</table>

**COSTS BY “BUDGET PERIOD”**

<table>
<thead>
<tr>
<th>Period</th>
<th>Start Date</th>
<th>End Date</th>
<th>Cost to Project</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>01-Apr-2016</td>
<td>31-Mar-2017</td>
<td>$10,000.00</td>
</tr>
<tr>
<td>2</td>
<td>01-Apr-2017</td>
<td>31-Mar-2018</td>
<td>$5,150.00</td>
</tr>
<tr>
<td>ALL</td>
<td>01-Apr-2016</td>
<td>31-Mar-2018</td>
<td>$15,150.00</td>
</tr>
</tbody>
</table>
How do I... manually adjust F&A?

**Note:** This method was developed for situations requiring a manual calculation for a specific expense item, such as “Participant Other” in an NSF Research Experience for Undergraduate (REU) application.

Certain expenses do not incur F&A charges, but there is no appropriate Budget Category to select. Or, the federal sponsor may have special limitations restricting F&A expense on a category that normally would incur F&A. The F&A cost in these situations must be manually adjusted. This method can be used for either simple modular budgets or for detailed budgets.

- Create an expense line in **Non-Personnel Costs** section of **Budget Items**.
- Click [Save].

- Add additional expenditures as needed
- Check the **Completed** box for **Budget Items**
- Select Budget > F&A
- Select Manual (line by line)

- Replace amount in Sponsors F&A and Requested F&A with $0.00.
  **Tip:** Just delete the values before saving; empty cells will be replaced with “0.00” during Save.
- Click [Save].

- Check the **Completed** box for F&A.
  **Note:** Drift = difference between automatic F&A calculation and manual F&A calculation.
Select **Budget > Cost Sharing**

Scroll to bottom of screen and check the **Indirect Costs > Inst** line: There should be no values displayed.

- Scroll back up and click [Save CS Data].
- Check the **Completed** box for Cost Sharing.
How do I... use 424 budgeting?

The 424 budgeting model is designed for users who have already calculated their budgets in Excel spreadsheets and only want to enter that data directly into Proposal Development (PD). Users who plan to develop their budgets in PD should continue to choose “Budget by Total Project” or “Budget Period by Period”.

Overview

- Data entry only
  - Adds rows and columns
  - Calculates project totals and F&A
  - Does not calculate inflationary increases
  - Does not calculate fringe benefits
  - Does not evaluate for any salary cap
- Modular or detail budgets
- Warns and/or prevents completion of budgets that exceed sponsor limits (e.g., modular budgets)
- CAL, ACAD, and SUMR appointments
- Institutional Base Salary (IBS) may be left blank

Note: Some sponsors, e.g., NIH, may permit applicants to not display the institutional base salary when it exceeds a salary cap. Be sure that the sponsor for your proposal allows this.

Some screens and processes are identical in all three budgeting models:

- **Budget Items, F&A, Cost Sharing, Modular Budget, and Justification** screens are unchanged.
- Adding existing or TBN staff records are still initially created from an alpha-split list.

Setup Questions

- **Will this proposal be using a Modular budget?** Click “Yes” or “No”.
- In **Budget Setup Information** choose “424 Budgeting” from the dropdown list.
Budget > Budget Periods and Setups

The budgeting type can be changed in Budget Periods and Setups. If budget information has already been entered, be sure to carefully check all Budget Items to ensure that expenses are still correct.

- Choose “424 Budgeting” from the dropdown list.
- Click the [Save] button at the top of the screen.

Budget > Budget Items

- Costs are entered in one of three main sections:
  - Personnel Costs
  - Non-Personnel Costs
  - Subcontractors
- If this is a modular budget, the “Modular Budget” section will also be available.

Personnel Costs

- Click the Add link to add additional personnel or choose the Budget link next to an existing name to open a detail screen.
• Verify that the Personnel Type and Role on Project sections are complete and accurate.
• Enter Base Salary, Months, Salary, and Fringe Benefits values.
  o Fringe Benefits will not calculate - must be entered correctly by user.
  o NIH salary cap also will not be calculated against the true Base Salary.
  o If the number of months is < 0, user must type the leading zero and the decimal point.
  o Remember to calculate inflationary increases.
• Total rows and Grand Total columns will be calculated by PD.
• Click the [Save] button at the top of the screen.

Non-Personnel Costs

• Select Add to add non-personnel costs.
• Enter description.
• Select Sponsor Budget Category from dropdown list.
• Enter Costs to Project for each budget period.
  o Remember to include inflationary increases if you wish.
• Click [Save] at the top of the screen.
**Subcontractors**

**Add or Import** to create a new subcontract.

- Select **Add or Import** to create a new subcontract.

**Add Subproject**

- Make your choice from the alpha-split list and click **Select**.
- In the new window, select the PI from the alpha-split list and click **Select** or enter the PI’s name and other requested information on the select PI screen.
• The Subcontractor is now added to the Budget Items tab.
• Click the **Open** link, on the right, under Detail Budgeting (do not click the Open Link, on the left, under Short Form) to access the subcontract.

**Note:** The Budget Items and Budget Detail screens and data entry for subcontracts are identical to the previous instructions for the primary applicant.

• Complete budget entry for the subcontractor.
• Remember to also complete the F&A.
How do I... print a copy of my proposal?

A user can print a copy of their proposal by accessing the proposal through Proposal Development, and selecting the “Finalize” tab from the Sidebar Menu. Then, select the “Eyeglasses” icon under the heading “Completed Form” to view a PDF version of the proposal. At this point, the user may print out the PDF document or save it to his/her computer.

How do I... view a proposal I’ve been working on?

There are a number of ways to view proposals. The first and possibly the easiest way is to log in to PennERA, select “My Proposals” from the Sidebar Menu, click on “Search For”, type in the Institution number, and click on the [Locate] button. This will display the specific proposal in question.

Since an Investigator has access to only their proposals, selecting “My Proposals” and “Show/ List” will display all of his/her proposals. Select the appropriate proposal from the list.

Administrators have access to all proposals in a particular ORG(s). Select “My Proposals” from the Sidebar Menu, and select “Search For”, “Show Additional Search Options” to search for the desired proposal from a number of options such as Principal Investigator, Institution Number, Sponsor, etc.
How do I... determine where a proposal is that’s been submitted for internal review?

A user can determine where a proposal is in its defined Routing and Approval path by accessing the proposal through any of the previous methods, selecting the “Finalize” from the Sidebar Menu, and clicking the “Open Full” icon to access the routing and status.
Appendix B: Best Business Practices

Naming Conventions for files to be uploaded
- Create separate folders for the attachments needed for each proposal
- Name Word Documents and PDF files similar to those in Proposal Development (Summary, Aims, etc.) to make them easier to retrieve

Working Collaboratively Across Schools
- Security for Proposals is established by central administrators.
- PIs have access to all proposal on which they are the Primary Investigator
- Business Administrators have access to proposals that are submitted under their ORG numbers
- If working with another School/Center or non-authorized ORG, users can designate authority to others
- From the Navigation Menu select Profile > Delegation > [Add] and select the person you will be working with on the proposal. Determine if they are to have View or Edit access to your proposals.
Appendix C: PennERA Proposal Development Frequently Asked Questions (FAQs)

Questions

- Where can I find out how to do things in PD that I’ve forgotten from training and aren’t questions in this FAQ?
- The department (ORG) that is going to manage the grant is different from the PI’s Home Department and the department showing as the Primary Associated Department, how do you change the Primary Associated Department?
- Many folks work on grants in my department, who should start the proposal and generate the PennERA Proposal ID#?
- My PI can’t remember their PennKey and pass word, how do they reset their password?
- How can I download and save a copy of the proposal on my PC?
- There is a proposal that needs the Department Chair’s approval but she is on vacation and never granted “designee” authority to anyone in PD? How can this proposal be approved?
- The PI created the proposal and answered the set-up questions. It turns out the wrong Program Announcement/funding opportunity was selected. How can the Program Announcement/funding opportunity be changed to the correct one without losing all my work?
- Where can I find out if a proposal should be created and submitted using PennERA Proposal Development (PD) and which proposals should be created as system-to-system (S2S) or generic (non-S2S) records?

Q: Where can I find out how to do things in PD that I’ve forgotten from training and aren’t questions in this FAQ?
Answer: Go to the PennERA reference website http://www.upenn.edu/researchservices/PennERA.html to link to various documents, including the Proposal Development User’s Guide and various quick ref and FAQ documents.

Q: The department (ORG) that is going to manage the grant is different from the PI’s Home Department and the department showing as the Primary Associated Department, how do you change the Primary Associated Department?
Answer: Select the Setup Questions tab in the proposal and then in General Proposal Properties section of the screen, click on the Add link just to the right of Associated Departments. This will launch a “Departments” window. In this new window, choose the desired ORG value from the list of values pull-down just under the alphabetic split. When the ORG value you want is highlighted, click the Select button at the top right of the window.

This will return you to the Setup Questions screen and the ORG value with description will have been added to the list of Associated Departments for this proposal. If you want this newly added value to be the Prime Associated Department, click the Prime radio button to the right of the ORG description. Next click the Save icon in the upper left corner of the screen. The screen will refresh as it saves and the new ORG will now be listed first in the list with Prime radio button selected.
The original ORG value can remain in the list of **Associated Departments** if a sub-award is planned to that ORG. It can be removed by clicking the Remove icon, the old ORG can be removed from the list of Associated Departments for this proposal.

Q: Many folks work on grants in my department, who should start the proposal and generate the PennERA Proposal ID#?
**Answer:** There is no one correct answer to this question. Different organizations within the University do business in different ways. What works best in one organization may not be the best choice for another. If your School/Center has given instructions that the proposal create step should be done by an individual with a specific role (for example the PI or the BA), please follow those instructions.

The most important point is that regardless of whether the original proposal record is created by the PI or by staff, communications between those involved is essential. All those involved in the proposal process in your area should understand who will create the record and when it then is available. The individual who does create the original proposal record, should be sure that both the PI and the Primary Associated Department are assigned correctly to the record. This helps ensure that the appropriate secured access is available to those who need it.

Q: My PI can’t remember their PennKey and password, how do they reset their password?
**Answer:** If you do not have a PennKey, or if you have a PennKey but forgot your password, go to the PennKey web site for more information at http://www.upenn.edu/computing/pennkey/. If you have any trouble with the PennKey process, contact your Local Support Provider. For a contact list, go to http://www.upenn.edu/computing/view/support/.

Q: How can I download and save a copy of the proposal on my PC?
**Answer:** The proposal can be downloaded (or viewed or printed in its entirety) only after all the Tabs on the proposal have been completed and on the Finalize screen, the pdf for each of the Form Pages has been built and the Assemble Application has been completed.

On the Finalize screen, go to the Submit for Internal Review section. Under the Components for Initial Application subsection, Proposal is listed. On the Proposal line, click on the “View” icon for the Completed Form, it will launch a window containing a pdf rendering of the entire proposal. The proposal pdf can then be saved, printed or viewed by selecting the corresponding Adobe Acrobat/Reader icons (diskette, printer or page navigation arrows) from the window’s toolbar.

Q: There is a proposal that needs the Department Chair’s approval but she is on vacation and never granted “designee” authority to anyone in PD? How can this proposal be approved?
**Answer:** Use the Support icon in the PennERA application or via email (PennERAhelp@lists.upenn.edu) to provide the proposal # and the Associated Department (Resp) ORG, and describe the situation. Module Administrators can then bypass the Department Chair approval step for this proposal, moving it forward in the approval process. Each School/Center will need to decide if, in their view, the proposal should be approved and move on to Research Services and eventual submission prior to obtaining the Department Chair’s approval. It is recommended that Departments and Schools avoid the delays caused by these situations by ensuring that approval steps have at least two people on them, but requiring only one of them to approve.

Q: The PI created the proposal and answered the set-up questions. It turns out the wrong Program Announcement/funding opportunity was selected. How can the Program Announcement/funding opportunity be changed to the correct one without losing all my work?
**Answer:** Because of the wide variety of screen templates used, please contact the PennERA Help Desk, providing the correct FOA # and the proposal (institution) #. The Team will provide you with appropriate next steps.
Q: Where can I find out if a proposal should be created and submitted using PennERA Proposal Development (PD) and which proposals should be created as system-to-system (S2S) or generic (non-S2S) records?

Answer: All new and competitive renewal submissions should have a new record created in PennERA. If the proposal is being submitted to Grants.gov, check our reference website for information about S2S submissions. If the proposal is not being submitted through Grants.gov, a generic record should be created. New records for noncompeting applications or revisions to existing awards (supplementals) should not have a new record created in PennERA. If you are not certain what to do, contact the PennERA Help Desk.
Appendix D: NSF System-to-System (S2S) FAQs

Click on a specific question to view the answer, or browse all the FAQs and responses below.

1. How do I know if I can submit an NSF proposal to Grants.gov (GdG) using PennERA system-to-system (S2S)?

   • If the NSF Funding Opportunity Announcement (FOA) indicates that the proposal can be submitted to either Grants.gov or FastLane, then it can be submitted to GdG via PennERA S2S, with these exceptions:
     ◊ Collaborative proposals submitted separately by two or more institutions can only be submitted to FastLane and cannot use S2S.
     ◊ Fellowships submitted directly by the applicant – the potential Fellow – rather than The Trustees of the University of Pennsylvania can only be submitted through FastLane.
     ◊ The institutional support portion of the award is setup as a PennERA generic record.
     ◊ NOTE: Current information about all S2S submissions is available at http://www.upenn.edu/researchservices/PennERA.html and by writing to PennERAhelp@lists.upenn.edu.

2. What should I do if I can’t find the FOA or if there is an old close date?

   • Always immediately notify the PennERA Help Desk if there are any questions about the FOA. We will work directly with NSF and/or InfoEd to quickly resolve any FOA issues.

3. I have a collaborative proposal but only Penn is submitting the proposal; the collaborator will be a subcontract on the Penn proposal. Can this be submitted S2S?

   • If the NSF Funding Opportunity Announcement (FOA) indicates that the proposal can be submitted to either Grants.gov or FastLane, then it can be submitted to GdG via PennERA S2S, with these exceptions:
     ◊ Collaborative proposals submitted separately by two or more institutions can only be submitted to FastLane and cannot use S2S.
• NSF also defines this type of proposal as “collaborative”, but it can be submitted S2S via GdG.
• See FAQ #1 regarding collaborative proposals submitted by two or more separate institutions.

4. How does a PennERA S2S submission to GdG get into FastLane?
• PennERA creates and submits the GdG data package.
• NSF will retrieve the proposal after they are notified that it has passed GdG validations.
• NSF then electronically inserts the proposal into FastLane. The PI and also the PennAOR's mailbox will be notified, and information about any errors or warnings, with instructions about how to correct these, will also be provided.

5. Do I need to create a proposal record first in FastLane?
• It is not necessary to first create the proposal record in FastLane. Only one record in PennERA needs to be created and completed.

6. Will I still be able to make changes to the FastLane application?
• Once the proposal is in FastLane after initial submission through Grants.gov, changes may be made through the FastLane Update Module.

7. Where can I find NSF’s instructions for completing GdG submissions?
• There are two user guides that need to be followed, in addition to any special instructions in the announcement (FOA):
  ◊ NSF Grants.gov Application Guide

8. How do I know if I have correctly created the PennERA S2S record?
• On Setup Questions, the screen template should be “424 R&R NSF Dynamic (electronic submission)”. 
• If this is not the template present in the record, contact PennERAHelp@lists.upenn.edu for assistance; do not change the template.

9. Which budgeting model should I choose on the Setup Questions tab?
• The preferred budgeting models are either “Budget by Total Project” (the default setting) or “Budget period by period”.
• “424 Budgeting” is not required just because the proposal uses the SF424 formset. It may be selected but the other methods are encouraged because they require much less data entry and verification.

10. How do I enter the Sponsor Credential in the proposal record?¹
• This is the 9-digit NSF FastLane ID and is a required data element for the PI and all co PD/PI’s.
• Instructions for adding this information to the PennERA Profile can be found on page 19 of the PennERA Proposal Development User Guide. A link to this guide can be found at http://www.upenn.edu/researchservices/PennERA.html.
• If this information is added after a proposal record has been created, the information will have to be selected in the existing Proposal Development record.
  ◊ Once this information has been entered in the Profile, future records created will automatically contain it.
  ◊ For non-Penn personnel, the information needs to be included in the record at the time they are added to the list of personnel in the record.
• PD currently will submit applications with this information missing.
  ◊ The proposal will still be inserted into FastLane but won’t be associated with the PI so s/he will not be able to access it.
  ◊ The proposal will need to be resubmitted through Grants.gov with the credential included. See FAQ #10.
  ◊ Contact ORS pre-award for assistance in obtaining an NSF FastLane ID.

¹If credential and degree information are added after the proposal has been created in PennERA, a departmental person with PennERA Profile edit privileges will have to manually select the value in the proposal record. However, records created after this information has been included in the Profile will have the information automatically populated on the Personnel tab detail.
11. How do I enter the Degree Type and Degree Year information in the proposal record on the Personnel tab?
   - NSF requires that the proposal include the Degree Type (abbreviation) and Degree Year for the PI. NSF does not extrapolate the data from the PI’s FastLane Profile.
   - Instructions for adding this information to the PennERA Profile can be found on page 19 of the PennERA Proposal Development User Guide. A link to this guide can be found at http://www.upenn.edu/researchservices/PennERA.html.
   - If this information is added after a proposal record has been created, the information will have to be selected in the existing Proposal Development record.
     ◊ Once this information has been entered in the Profile, future records created will automatically contain it.
   - PD currently will submit applications with this information missing.
     ◊ FastLane will provide a warning message: “The Degree Type was entered as <UNKW> and the Degree is defaulted to 1900...”
     ◊ Instructions for fixing the problem will also be provided: “...If this information is not correct, please go to Proposals, Awards and Status in FastLane, log in as the PI and update the Degree Information for the PI.”

12. How do I submit a changed/corrected application if there is a problem with my submission?
   - If no warning message is received from FastLane but a problem is identified by the PI in the submitted proposal:
     ◊ The PennAOR needs to withdraw the application from FastLane.
     ◊ Do NOT identify the proposal as a “Changed/Corrected Application” on the SF424 R&R tab, nor is the first Grants.gov tracking number needed in the Federal Identifier field on this same form.
     ◊ Resubmit the updated PennERA S2S record prior to the deadline to ensure on-time submission by FastLane.
   - In some instances, FastLane will indicate that the proposal has been inserted into FastLane with warning messages and that the FastLane Update Module should be used for changes.
     ◊ It is not necessary to resubmit the PennERA S2S record to GdG.
     ◊ Work with the ORS pre-award person who submitted the proposal to make the changes in the Update Module directly in FastLane.

13. The instructions for an REU (Research Experience for Undergraduates) application require the use of the category “Participant Other Costs”. NSF excludes this from MTDC and doesn’t award any F&A, but PennERA is calculating F&A. How do I fix this?
   - A manual adjustment of the F&A calculation needs to be done.
   - Please see the Table of Contents of the User Guide, Appendix A, for the topic “How do I... manually adjust F&A?”

14. This project involves foreign countries. How should I list these in section 6a of Other Project Info so that the information correctly populates to FastLane?
   - Enter each country name, followed by a comma.
   - We are currently working with NSF to determine whether or not there is a 10-country limit to this list.

15. The PI wants to list suggested reviewers and names of potential reviewers to exclude. How should these be entered on the form?
   - Enter each person's name, followed by a comma.

16. How can I list some Key Personnel on the Senior/Key Personnel form but not in the R&R Detail Budget form?
   - Make certain that you have not selected 424 budgeting as the budget method on Setup Questions.
   - Confirm with ORS Pre-Award that it is allowable for anyone who is Key Personnel on the project to be only listed on the Senior/Key Person form and not in the detail budget.
   - Contact the PennERA Help Desk for assistance.
   - NSF has provided updated instructions in their Proposal Preparation Guide; however, there is ongoing review by NSF about the proper way to handle this situation. Please contact the PennERA Help Desk if you plan to submit an NSF proposal that has this issue.
17. The PI of this proposal isn’t required to have any effort. Will it fail at Grants.gov if their effort = 0%?
   • Make certain that you have not selected 424 budgeting as the budget method on Setup Questions.
   • **Confirm with ORS Pre-Award** that 0% effort for the PI is allowable.
   • Contact the PennERA Help Desk for assistance.
   • NSF has provided updated instructions in their Proposal Preparation Guide; however, there is ongoing review by NSF about the proper way to handle this situation. Please contact the PennERA Help Desk if you plan to submit an NSF proposal that has this issue.

18. How do I handle cost-sharing in an NSF proposal record?
   • Make certain that you have not selected 424 budgeting as the budget method on Setup Questions.
   • **Discuss the cost-sharing aspects of the proposal with ORS Pre-Award** before contacting the PennERA Help Desk for assistance in how to provide the information in the PennERA record.
   • NSF has provided updated instructions in their Proposal Preparation Guide; however, there is ongoing review by NSF about the proper way to handle this situation. Please contact the PennERA Help Desk if you plan to submit an NSF proposal that has this issue.
